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Precision Detectors, Inc., 
Electronic End User License Agreement 
 

NOTICE TO USER: THIS IS A CONTRACT. BY INDICATING YOUR ACCEPTANCE. DURING 
INSTALLATION, YOU WILL BE ASKED TO ACCEPT ALL THE TERMS AND CONDITIONS OF 
THIS AGREEMENT. 

This Precision Detectors, Inc. (PDI) End User License Agreement accompanies a Precision Detectors 
software product and related explanatory materials. The term "Software" shall include all software 
packages delivered to you by PDI and any upgrades, modified versions or updates of the Software 
licensed to you by PDI. This copy of the Software is licensed to you as the end user for use by you and 
other users of a specific PDI hardware system purchased, leased or rented by you. 

Please read this Agreement carefully. 

PDI grants to you a non-exclusive license to use the Software, provided that you agree to the following: 

1. Use of the Software  

a) You may install the Software in a single location on a hard disk or other storage device; 
install and use the Software on a file server for local execution over your network (but not for 
the purpose of copying onto a local disk or other storage device); for use only with the 
specific system; 

b) You may make backup copies of the Software; 

c) You may transfer the Software from one computer to another over your network, or relocate 
the Software on your site, but you may not copy it to additional sites over the network or 
make additional copies for use on additional networks or sites for use with other hardware; 

d) You may copy the Software to the personal computer of Users and such Users may use the 
software to examine, recompute and print out files collected in conjunction with the System;  

e) You may obtain additional electronic copies of the Software directly from PDI for the cost of 
media, handling and shipping. 

2. Copyright  

The Software is owned by PDI and its suppliers, and its structure, organization and code are valuable 
trade secrets of PDI and its suppliers. The Software is also protected by United States Copyright Law 
and International Treaty provisions. You agree not to modify, adapt, translate, reverse engineer, 
decompile, disassemble or otherwise attempt to discover the source code of the Software. You may 
use trademarks only to identify printed output produced by the Software, in accordance with accepted 
trademark practice, including identification of trademark owner's name. Such use of any trademark 
does not give you any rights of ownership in that trademark. Except as stated above, this Agreement 
does not grant you any intellectual property rights in the Software. 
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3. Transfer  

You may not rent, lease, or sublicense the Software. You may, however, transfer all your rights to use 
the Software to another person or entity, provided that you transfer this Agreement with the Software. 

4. Warranty  

The Software delivered to you is PDI's current standard version and performs as described in PDI's 
brochures. For a period of one year from the date of delivery, PDI agrees to correct defects that the 
user identifies as not performing as described in PDI's brochures. PDI DOES NOT AND CANNOT 
WARRANT THE PERFORMANCE OR RESULTS YOU MAY OBTAIN BY USING THE 
SOFTWARE OR DOCUMENTATION. PDI MAKES NO WARRANTIES, EXPRESS OR 
IMPLIED, AS TO MERCHANTABILITY, OR FITNESS FOR ANY PARTICULAR PURPOSE. IN 
NO EVENT WILL PDI BE LIABLE TO YOU FOR ANY CONSEQUENTIAL, INCIDENTAL OR 
SPECIAL DAMAGES, INCLUDING ANY LOST PROFITS OR LOST SAVINGS, EVEN IF A PDI 
REPRESENTATIVE HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES, OR 
FOR ANY CLAIM BY ANY THIRD PARTY. Some states or jurisdictions do not allow the 
exclusion or limitation of incidental, consequential or special damages, or the exclusion of implied 
warranties or limitations on how long an implied warranty may last, so the above limitations may not 
apply to you. 

5. Governing Law and General Provisions  

This Agreement will be governed by the laws of the State of Massachusetts, United States of 
America, excluding the application of its conflicts of law rules. This Agreement will not be governed 
by the United Nations Convention on Contracts for the International Sale of Goods, the application of 
which is expressly excluded. If any part of this Agreement is found void and unenforceable, it will not 
affect the validity of the balance of the Agreement, which shall remain valid and enforceable 
according to its terms. You agree that the Software will not be shipped, transferred or exported into 
any country or used in any manner prohibited by the United States Export Administration Act or any 
other export laws, restrictions or regulations. This Agreement shall automatically terminate upon 
failure by you to comply with its terms. This Agreement may only be modified in writing signed by 
the President of PDI. 

6. Notice to Government End Users.  

If this product is acquired under the terms of; 

(i) a GSA contract - Use, reproduction or disclosure is subject to the restrictions set forth in the 
 applicable ADP Schedule contract; 

(ii) a DOD contract - Use, duplication or disclosure by the Government is subject to restrictions as set 
 forth in subparagraph (c) (1) (ii) of 252.227-7013; 

(iii) a Civilian agency contract - Use, reproduction, or disclosure is subject to 52. 227-19 (a) through 
 (d) and restrictions set forth in the accompanying end user agreement. 
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7. Only Terms and Conditions  

These Terms and Conditions are the only terms and conditions related to the use of this software, they 
supercede any previous agreement with respect to the software, and may only be altered in a written 
agreement signed by PDI and you. 

Unpublished-rights reserved under the copyright laws of the United States. Precision Detectors, Inc., 10 
Forge Park, Franklin, MA 02038. 

Your acceptance or decline of the foregoing Agreement [was or will be] indicated during installation. 

 

Special Additional Warranty Terms  

In addition to the Warranty Terms and Conditions under which the System is purchased, the 
following items are excluded: 

(i) Breakage of glass cuvettes and flow cells, 

(ii) Breakdown of the photon detector by turning the PD2000DLS electronics module power ON 
without the fiber optic input connector correctly capped to prevent the input of ambient room 
light.  Correct capping of the connector is achieved by correctly fitting a light tight cap or by 
connecting the correct fiber optic with its far end correctly attached to a fully-operational PDI 
light scattering platform. 
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Warnings and Safety Information 
 

Precision Detectors instrumentation is designed to meet all applicable safety standards. The following 
precautions should be followed to minimize the possibility of personal injury or damage to property 
during operation. 

1. There are no user serviceable components inside the detector modules. Do not remove the cover of 
either module without authorization from Precision Detectors. If it is necessary to remove the cover, 
make certain that the power is off to both modules.  

2. Do not apply power to either module unless the fiber optic cable is connected to both modules. If 
stray light (room light) enters the system, the high light level may destroy the photomultiplier and/or 
its power supply. This failure is specifically excluded from the warranty. 

3. The instrument must be plugged into a grounded power line. It is strongly recommended that both 
modules are connected to a common ground.  

4. The detector is designed for an operating environment of 10-40oC.  

5. In many cases, the toxicological nature of samples that are measured by the detector is not known. 
The user should take proper precautions are taken to avoid personal contact with the sample. 

6. If an organic solvent is used, make certain that the laboratory is well ventilated. Do not use an open 
flame and do not install any equipment that can cause sparks in the laboratory. 

7. Discard all samples in a manner that is consistent with the safety and environmental regulations of 
your organization. 

REQUIRED STATEMENTS  

The United States Department of Agriculture, Department of Health and Human Services and the NIPH 
require that the following information be supplied. 

• The following controls and adjustments are available:  
An ON/OFF switch on the front panel controls main power to the system. 

• Location of NIPH Label:  
The NIPH laser warning is located on the laser housing. 

• Caution - Use of controls or adjustments, or performance of procedures other than those 
described herein may result in hazardous radiation exposure.  
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LABELS: 

The following labels are affixed to the detector: 

 
Electrical Requirements 100/120/230/240 V 50/60 Hz, 15 W 

 
This unit is to be serviced by factory authorized personnel 
only. 

 

Protective conductor terminal 

 
Earth Ground Terminal 

Danger: Laser radiation when open. Avoid direct exposure to 
beam 
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Chapter 1 

Introduction 
 

1.1 OVERVIEW  

PrecisionAcquire32 and Discovery32 are application programs that are used with a broad range of light 
scattering detectors manufactured by Precision Detectors, Inc. These detectors are generally used with 
HPLC (High Performance Liquid Chromatography), GPC (Gel Permeation Chromatography), SEC (Size 
Exclusion Chromatography) and FPLC (Fast Protein Liquid Chromatography) systems for the 
determination of the molecular weight distribution, the hydrodynamic radius and related parameters of 
proteins, virons and liposomes as well as synthetic polymers. 

1.2 PrecisionAcquire32 

PrecisionAcquire32 is used to set up the various parameters that are used to collect light scattering data. A 
detailed discussion of this program is presented in Chapters 3 and 4. The program is configured for use 
with the PD2000DLS A/D interface box or the PDConnect A/D interface box. The program requires 
connection with one of the interface boxes in order to access all of the various parameters. 

Two types of commands can be set via PrecisionAcquire32: 

• System parameters - which refer to parameters that define the system configuration and other 
settings that are infrequently changed. An example of a system parameter is the selection of the 
port used for communications between the computer and the analyzer module).  

• Operating parameters - which refer to parameters that are specifically set for a given experiment 
or series of experiments. These commands are frequently changed during operation and the user 
will likely vary them to determine the optimum conditions for the measurement. 

The user should note that the above division of parameter types is not absolute. In some facilities, the 
detector is used for a variety of applications with more than one system and it may be necessary to change 
System Parameters from time to time. Similarly, if the system is dedicated to a single application, it is 
possible that once the Operating Parameters have been determined, they are rarely altered.  

Raw data collected via PrecisionAcquire32 can be processed via Discovery32. If desired, raw data can be 
exported as an ASCII file or directly to third party software.  

     1 



 

1-2  Discovery32 – Chapter 1 

1.3 Discovery32 

Discovery32 is used to present, process, view, report and export light scattering data that has been 
collected via PrecisionAnalyze32 and other detectors (e.g. Refractive Index and UV absorbance). The 
program is used with for HPLC, GPC, FPLC and SEC systems and allows the analyst to view 
chromatograms, calculate molecular weight and size distributions, determine the hydrodynamic radius, 
etc. In addition, this program allows the user to view data from several runs at a given time. Discovery32 
can be used to generate calibration factors for the detector. A detailed discussion of this program is 
presented in Chapters 4-9. 

1.4 INSTRUMENTATION USED WITH PrecisionAcquire32 AND Discovery32 

PrecisionAcquire32 and Discovery32 are used with the following Precision Detectors Light Scattering 
systems: 

1.4.1 PD2010  

The PD2010 is a static light-scattering system with the detector positioned at 90º to the incident laser 
beam. This system is available as an ambient temperature bench-top configuration, a high temperature 
bench-top configuration or installed inside the temperature chamber of a Waters 410 or 2410 Differential 
Refractometer. The detector can be used at temperatures up to 50º C. This configuration is typically used 
to determine the molecular weight of smaller molecules, such as proteins and low molecular weight 
polymers. It is frequently installed with the PD2000/DLS (a dynamic light-scattering detector) as an 
accessory to provide information about the size of the molecules. 

1.4.2 PD2020  

The PD2020 is a static light-scattering system with detectors positioned at both 15º and 90º to the incident 
laser beam. This system is available in an ambient temperature bench-top configuration or can be installed 
inside the temperature chamber of a Waters 2410 or 410 Differential Refractometer. The detector can be 
used at temperatures up to 50º C. This configuration is used to determine the molecular weight, radius of 
gyration and other parameters for a wide range of molecular sizes, typically from 100 to 10,000,000 
daltons. It is frequently installed with the PD2000/DLS (dynamic light-scattering detector) as an 
accessory to provide information about the size of the molecules. 

1.4.3 PD2000/DLS 

The PD2000/DLS is a dynamic light-scattering system consisting of a detector positioned at 90º to the 
incident laser beam, a photon counter and autocorrelator electronics. This system is available in an 
ambient temperature bench-top configuration or installed inside the temperature chamber of a Waters 410 
or 2410 Differential Refractometer. The detector can be used at temperatures up to 50º C and is normally 
used to determine the hydrodynamic radius (Rh ) of molecules over a very wide range (1.5 nm to 1000 
nm).  
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1.4.4 PD2040  

The PD2040 is a high temperature light-scattering detector that can operate at up to 250º C. It includes 
detectors positioned at both 15º and 90º to the incident laser beam. This configuration is installed inside 
the temperature chamber of any one of the following commercially available high temperature GPC 
systems, Waters 150C, Waters GPC2000, Polymer Labs GPC-110 or Polymer Labs GPC-210 high-
temperature system or inside a custom temperature chamber. 

1.5 CONVENTIONS USED IN THIS MANUAL 

PrecisionAnalyze32 and Discovery32 are Windows applications that conform to the general conventions 
of Microsoft Windows. In this discussion, we will assume that the user has a general understanding of the 
operating system and the user should note the following: 

• It is assumed that the OK or Run button should be selected after all commands in a dialog box 
have been selected. 

• Dialog boxes and commands that are common to most Windows application programs will not be 
discussed. As an example, the Open command on the File menu presents a dialog box that is used 
to open a file. This dialog box is identical to the Open dialog box found in other Windows 
applications such as Microsoft Word and Microsoft Excel. 

• In many instances, there is more than one way to perform a specific activity. As an example, in 
Discovery32, you can access the Setup Calculation dialog box by selecting Setup Calculation on 
the Options menu or by pressing the corresponding icon (the Wrench icon). We will describe the 
use of the commands and indicate the role of each icon as we describe the program. 

• The user can obtain a pop-up menu containing commands that are commonly used for processing 
data in various windows that contain data by right clicking on the data. As an example, when the 
Chromatogram window is presented, a pop-up menu allows for commands such as setting the 
baseline or normalizing a user-selectable region.  

     1 



 

1-4  Discovery32 – Chapter 1 

1.6 CONTENTS OF THIS MANUAL 

This manual includes the following: 

• Chapter 2, Installation describes how to load and configure the program for the specific system 
that you are using. It includes a sample experiment that can be used to demonstrate that the 
computer and the detector module are functioning in an acceptable manner. 

• Chapter 3, Introduction to PrecisionAcquire32 describes the details of the data acquisition 
program and explains the role of each command. 

• Chapter 4, Selecting Parameters for Data Acquisition with PrecisionAquire32 discusses how 
PrecisionAcquire 32 is used to establish an analytical method and collect data. 

• Chapter 5, Introduction to Discovery32 describes the details of the data processing program, 
discusses the features that are accessed via the main window and explains how files are selected 
for processing. 

• Chapter 6, The Chromatogram Window discusses the processing functions that are provided 
via the chromatogram window.  

• Chapter 7, Using Discovery32 to Study Proteins provides a tutorial to explain how light 
scattering data is used to obtain information about proteins. 

• Chapter 8, Using Discovery32 to Study Synthetic Polymers provides a tutorial to explain how 
light scattering data is used to obtain information about synthetic proteins. 

• Chapter 9, Exporting Data explains how the data can be formatted for use with external 
programs. 

1.7 FOR FURTHER INFORMATION 

For further information, please refer to: 

• The User Manual provided with your Precision Detectors Light Scattering System. 

• On-line help files, which are accessed via the help command on the help menu. 

General references on Light Scattering include:  

1. Tanford, C., Physical Chemistry of Macromolecules, John Wiley & Sons, Inc., New York, (1961), 
Chapter 5. 

2. Kerker, M., Electromagnetic Scattering, Pergamon Press, Oxford, (1963). 

3. Ford, N.C. Jr., in Dynamic Light Scattering - Applications of Photon Correlation Spectroscopy, R. 
Pecora, ed., Plenum Press, New York, (1985), Chapter 2. 

4. Katime and J. R. Quintana, in Comprehensive Polymer Science, Booth and Price, eds., Pergamon 
Press, Oxford, (1989), Chapter 5.
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Chapter 2 

Installation of PrecisionAcquire32 and Discovery32 
 

2.1 OVERVIEW 

This chapter describes the installation of the application software and interfacing the personal computer 
with the system. In addition, a short experiment is provided to allow the user to demonstrate that the 
system is functioning in an acceptable manner.  

2.2 INTERFACING THE DETECTOR TO THE PERSONAL COMPUTER 

Note: Do not turn on the power to the Detector until you are instructed to. 

Connect the detector to the personal computer as described in the User’s Manual supplied with the 
detector. 

Note: The personal computer and printer should be connected to the same ground as the HPLC/GPC/SEC 
system.  

2.3 INSTALLING THE APPLICATION PROGRAMS ON THE PERSONAL COMPUTER 

Two programs are provided on the Discovery32 CD: 

• PrecisionAcquire32 - which is used to establish the data acquisition protocol and collect data. 

• Discovery32 - which is used to process data and generate reports. 

To install PrecisionAcquire32: 

a) Place the distribution disk in the CD drive. The Precision Detectors Software installation screen 
(Figure 2-1) will be presented: 
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Figure 2-1:  The Precision Detectors Software Installation Screen  

b) Select Install Software to present the Software Installation screen (Figure 2-2). 

 
Figure 2-2:  Software Installation Screen 
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c) Select PrecisionAcquire32 and press Enter. The PrecisionAcquire32 installation program will 
present a series of screens that describe the installation process. Follow the instructions presented on 
each screen. During the installation, you will be prompted for the software license key (which is 
included in the documentation), your name and organization, the type of A/D box which is to be used 
(PD2000DLS or PDConnect) and the serial number of the A/D box.  

d) After the installation is complete, a dialog box will be presented to prompt you for the calibration file 
disk (which is provided with the system). Place the disk in drive A and click OK to download the 
calibration file. 

To install Discovery32, return to the Precision Detectors Software Installation screen (Figure 2-2) and 
select Discovery32. The install program presents a series of screens that describe the installation process. 
Follow the instructions presented on each screen.  

2.4 SETTING PARAMETERS FOR THE TEST EXPERIMENT 

2.4.1 Parameter Types 

PrecisionAcquire32 includes a number of dialog boxes that are used to enter a broad range of parameters 
that relate to data acquisition. These parameters can be generally classified into two general categories:  

• System parameters - which refer to settings that are changed infrequently. In many cases, these 
parameters are dependent on the configuration of the system or relate to user preferences. As an 
example, once the COM port for communication between the computer and the analyzer module 
has been selected, it is not normally changed.  

• Operating parameters - which refer to parameters that are specifically set for a given experiment 
or series of experiments. These parameters are frequently changed during operation of the system 
and are sample dependent.  

2.4.2 Setting Parameters for the Test Experiment 

This section describes setting system parameters and operating parameters for the test experiment 
provided in Section 2.7. The Setup dialog boxes described below (Section 2.4.3-2.4.12) are accessed via 
the Setup menu. The first six dialog boxes (Section 2.4.3-2.4.8) are common to all systems and the last 
four entries (Sections 2.4.9-2.4.12) are used only with systems that include the PD2000 Interface box. In 
addition, the user should enter information in the Single Run Info dialog box, which is described in 
Section 2.5.  

The approach used in this section is to describe the appropriate settings that should be set so that the user 
can demonstrate that the system is functioning in an acceptable manner (it should be recognized that this 
section is not meant to provide optimum parameters for a given sample).  

Note: A detailed discussion about the role of each parameter and how it affects the measurement is 
presented in Chapter 4.  
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Parameters for two distinct test experiments are provided. 

• Analysis of BSA - Analysts who expect to be studying polymers of a biological nature should use 
this experiment. 

• Analysis of Polystyrene - Analysts who expect to be studying synthetic polymers should use this 
experiment. 

2.4.3 Select Active Detectors Dialog Box 

The Select Active Detectors dialog box (Figure 2-3), which is accessed by selecting Detectors on the 
Setup menu, is used to indicate the detectors that are connected to the system and to select a variety of 
operating parameters. 

 
Figure 2-3:  The Setup Active Detectors Dialog Box 
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For the purposes of the test experiment: 

a) Select the detector channel(s) that that are present in your system. 

b) Select 0.10 for the Collection Fraction if a BSA sample is to be analyzed. If a polystyrene sample is 
to be analyzed, select 0.75.  

c) Deselect the check box adjacent to Use as Temp Sensor. 

d) The Coefs for Temp Conv field should be set to 0.  

e) Deselect the three check boxes at the bottom of the dialog box. 

2.4.4 Setup Display Dialog Box 

The Setup Display dialog box (Figure 2-4) is used to indicate the desired display format. 

 
Figure 2-4:  The Setup Display Dialog Box  

For the purposes of the test experiment: 

a) Check the detectors that were selected on the Select Active Detectors dialog box (Figure 2-3). 

b) Select one of the radio buttons in the Use for Y-Axis Label column. 
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2.4.5 The Calibration Setup Dialog Box 

The Calibration Setup dialog box (Figure 2-5) is used to enter/edit calibration data that is obtained from 
the Certificate of Calibration supplied with the detector. 

 
Figure 2-5:  The Calibration Setup Dialog Box 

For the purposes of the test experiment: 

a) Enter the calibration values (if known). They are usually supplied on the Certificate Of Calibration 
provided with the system. 

b) Select the Mw Calc Type that corresponds to your system. 

c) Select the Instrument Concentration Source used with your system (it is not necessary to edit the 
Run Conc Source Field). 

d) Select No Smoothing in the MW Calc Method field. 
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2.4.6 The System Configuration Dialog Box  

The System Configuration dialog box (Figure 2-6) is used to define the communications protocol between 
the personal computer and the analyzer module. In addition, it is used to indicate where data files and the 
calibration file should be stored.  

 
Figure 2-6:  The System Configuration Dialog Box 

For the purposes of the test experiment: 

a) Indicate the Comm Port to which the Analyzer Module is connected (in most cases, COM1 is used). 

b) Select the Baud Rate to be used (38400 is normally used). 

c) Select the number of Stop bits (in most cases, select 1). 

d) Indicate the directory into which data files should be stored.  

e) Indicate the file that is should be used for calibration. The default file that was sent with the software 
should be used. This file optimizes the interface box and the filename matches the serial number on 
the PD2000/DLS module. The Disable Calibration File Loading check box should not be checked. 

f) Place checkmarks in the three check boxes at the bottom of the dialog box.  
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2.4.7 The Analog Board Setup Dialog Box 

The Analog Board Setup dialog box (Figure 2-7) is used to establish communication parameters between 
the computer and the Analog Board on the analyzer module. 

 
Figure 2-7:  Analog Board Setup Dialog Box 

For the purposes of the test experiment: 

a) Set the Sample Rate to 100 Samples/sec (except in Japan where the 90 samples/sec rate should be 
chosen). 

b) Deselect the two check boxes. 

2.4.8 Export Options Dialog Box 

The Export Options dialog box (Figure 2-8) is used to indicate the format that the data should be exported 
in to meet the requirements of third party programs for data processing.  
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Figure 2-8:  The Export Options Dialog Box  

For the purposes of the test experiment, leave all square boxes unchecked. 

Note: If your system includes the Precision Detectors Connect Interface Box, omit Sections 2.4.9 to 
2.4.13 and proceed to Section 2.5.  

2.4.9 Correlator Configuration Dialog Box 

The Correlator Configuration dialog box (Figure 2-9) is used to describe a number of correlator settings.  
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Figure 2-9:  The Correlator Configuration Dialog Box 

For the purposes of this experiment: 

a) Ensure that the Dilation Factor, Override Computed Slurp and Correlator Prescale Factors are 
as shown in Figure 2-9. 

b) Set the Rh Sampling Gate Level to 0. 

c) Set the Test Signal to off. 

d) Set the Correlator type to 64 Chan. 
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2.4.10 Correlator Analysis Setup Dialog Box  

The Correlator Analysis Setup dialog box (Figure 2-10) is used to set a variety of run parameters.  

 
Figure 2-10:  The Correlator Analysis Setup Dialog Box  

For the purposes of this experiment: 

a) Deselect the Special Store correlator raw data in *.znn box. 

b) Set the Viscosity and Refractive Index to that for the temperature and solvent that will be used for 
the measurement. 

c) Set Wavelength to 800.0, Tolerance 1 to - 0.001 and Tolerance 2 to 0.1. 

d) Select Corr should be set to 1. 

e) Base Type should be set to Linear fit. 
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2.4.11 Readback Status Dialog Box 

The Readback Status dialog box (Figure 2-11) is used to ensure that the settings on the Setup Correlator 
and Correlator Analysis Setup dialog boxes have been successfully downloaded to the box. 

 
Figure 2-11:  Readback Status 

When this dialog box is opened, check that the parameters in the Readback column correspond to the 
values that were entered on the previous dialog boxes. 
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2.4.12 Autointegration Setup Dialog Box  

The Autointegration Setup dialog box (Figure 2-12) is used to describe how the initial calculations are to 
be performed.  

 
Figure 2-12:  The AutoIntegration Dialog Box. 

2.5 TEST EXPERIMENT  

2.5.1 Introduction to the Test Experiment 

The test experiments provided in this section are designed to demonstrate that the system is operating in a 
reasonable manner. While these experiments are not meant to formally qualify the system, they are very 
useful in checking that the computer is communicating with the analyzer module and the analyzer module 
is acquiring data in a reliable fashion.  

Note: Precision Detectors is capable of providing Instrument Qualification to verify that the system is 
capable of providing data to meet the needs of regulatory agencies or in-house requirements. For 
additional information, contact Precision Detectors or your local representative. 
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2.5.2 The Single Run Info Dialog Box  

The Single Run Info dialog box (Figure 2-13) is used to enter a broad range of parameters to describe the 
run. 

 
Figure 2-13:  The Single Run Info Dialog Box 

For the purposes of this experiment: 

a) Enter the file name to be used. The file name must include the $ character immediately after the 
period separating the two fields in the name (e.g. test.$00). 

Note: When entering information for a new sample, be sure to rename the run first, if you do not do this 
first, the software will ask if you want to overwrite the file.  

b) Enter as much information as possible in the fields on the left side of the dialog box. 

c) Deselect the Wait for Autostart Signal check box. 

d) Enter the Run Length for the chromatogram (see Section 2.5.3). 

e) Enter a Sample Interval of 1 sec. 
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f) Enter the Flow Rate (mL/min), Injection Volume (µL) and Sample Conc (mg/mL) as described in 
Section 2.5.3. 

g) Select the MW Calc Type to correspond to the system that you have. 

h) Select No Smoothing for Mw Calc Method. 

2.5.3 Chromatographic Conditions 

The test experiment is designed to determine if an eluting compound can be detected by the system. A 
short piece of narrow bore tubing (10 ft x 0.010”) should be placed in the system in place of the column 
and a Precision Detectors Inline Filter (part number SP2915) should be placed between the end of the 
tube and the flow cell.  

The mobile phase to be used for the test is dependent on the use of the system. 

• If you are working (intend to work) with an aqueous system, a phosphate buffered saline buffer 
pH 7.0 to 7.4 should the used as the mobile phase. This should be filtered through a 47 mm, 0.2 
µm Supor filter (Pall/Gelman). 

• If you are working (intend to work) with an organic solvent, THF should be used as the mobile 
phase. If the solvent bottle has not been used before, filtration is usually not necessary. If the 
solvent is used and has been recirculated, then it should be filtered through a 47 mm, 0.2 µm 
PTFE (TF-200) filter (Pall/Gelman). 

Allow the mobile phase to flow through the system for a few minutes to establish a baseline. To start data 
collection, press OK on the Single Run Info dialog box (Figure 2-12) and monitor the chromatograms. 
The signal should be <500 mV if an aqueous system is used and less than 300 mV of THF is used. The 
baseline should be stable and should not drift. Monitor the baseline for 10-15 minutes.  

Once you have established a satisfactory baseline, inject 100 µL of sample (aqueous system - BSA 2 
mg/mL, organic system - Polystyrene, MW = 96.4 kD (dissolved in THF), 2 mg/ML) and monitor the 
signal. A sharp peak should be observed after a few minutes.  

Note: In light scattering measurements, cleanliness is critical. The mobile phase and the sample must be 
filtered before use.  
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Chapter 3 

Introduction to PrecisionAcquire32 
 

3.1 OVERVIEW 

PrecisionAcquire32 is used to control PDI Light Scattering detectors used in high performance liquid 
chromatography, size exclusion chromatography, Fast Protein Liquid Chromatography and gel 
permeation chromatography. Data collected via PrecisionAcquire32 can be ported to Discovery32, for the 
determination of the molecular weight distribution, the hydrodynamic radius and related parameters of 
proteins, virons and liposomes and the generation of reports. 

This chapter describes the Main window of PrecisionAcquire32 (Figure 3-1) and includes: 

• Menu bar (Section 3.2) 

• Tool bar (Section 3.3) 

• Workspace (Section 3.4)  

• Status Bar (Section 3.5) 

A detailed discussion about the selection of parameters for data acquisition is presented in Chapter 4. 
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Figure 3-1:  The Main PrecisionAcquire32 Window 

3.2 THE MENU BAR 

The Menu Bar accesses a series of drop down menus that allow the operator to open various dialog boxes 
and select other operating conditions. 

3.2.1 File 

The File menu (Figure 3-2) is used to access a variety of data storage/retrieval commands (most of which 
are common to most Windows applications). 

Menu 
Bar 

Tool 
Bar 

Work 
Space 

Status 
Bar 
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Figure 3-2:  The File Menu 

Note: The commands that are active at a given instant are dependent on the status of the program. As an 
example, the Export command will not be active if no files are open. For the sake of clarity, we present 
the menu as if all commands are active. 

• New - inactive 

• Open - presents a dialog box to open an existing data file. The mode of operation is similar to 
that of other Windows application. All PrecisionAcquire files are of the form *.$*. 

• Save - inactive 

• Save As - inactive 

• Export - presents the Export Options dialog box (Figure 3-3), which is used to indicate the export 
format, type of data and directory for the data to be stored in if the data should be analyzed via an 
external program. The operator should select the desired format via the check box(es) and if 
either of the PLGPC formats is selected, the appropriate radio button should be selected. The 
directory buttons are used to select the desired folder in which the data is to be stored, as an 
alternative, the directory name can be typed in the field. Additional information about the Export 
Options dialog box is presented in Section 9.2. 
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Figure 3-3:  The Export Options Dialog Box 

If the data should be exported to a file as soon as the run is complete, select Enable Auto-Export 
at data-storage time. 

• Print, Print Preview and Print Setup are standard Windows commands and the four lines 
immediately above Exit indicate the most recently opened files. 

The last few files that have been opened are indicated immediately above the Exit command. 

• Exit closes the program. 

3.2.2 View Menu 

The View menu (Figure 3-4) is used to enable/disable the Toolbar and Status bar on the main window. 
When these features are activated, a check mark is indicated to the left of the command.  

 
Figure 3-4:  The View Menu 
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3.2.3 The Acquire Menu 

The Acquire menu (Figure 3-5) accesses a series of dialog boxes that are used to set conditions for and 
initiate a run.   

 
Figure 3-5:  The Acquire Menu 

3.2.3.1 Single Run 

Single Run accesses the Single Run Info dialog box (Figure 3-6), which is used to set parameters 
for data acquisition. 
 

 
Figure 3-6:  The Single Run Info Dialog Box 
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• File Name is used to enter the file name that is to be used to for data that is to be collected in this 
run to be collected. The format of the File Name must be xxxxxxxx.$xx (i.e. the first character 
after the period must be a $).  

Note: When you are preparing to analyze a fresh sample, make certain that you have renamed the run 
before entering other parameters. If you do not rename the run, the program will ask if you want to 
overwrite the existing file.  

If you indicate that you do not want to overwrite the existing file, any parameters that you have already 
entered will be lost and it will be necessary to re-enter them. 

• The Operator, Eluant and Sample fields are used to enter the relevant information. This data is 
stored with the sample data file.  

• The dn/dc, UV Ext. Coeff, Solvent Index (Refractive Index) and Temperature fields are used 
to enter the relevant parameters for the appropriate calculations in Discovery32 and should be 
entered.  

Note: If these parameters are not available before the collection of data, an approximation or dummy 
value can be used. The correct values can be entered during the data processing procedure. 

If an approximate or dummy value is used, do not select 0!. 

• The Run Length (min) field is used to enter the time period for the separation. This value cannot 
be changed after the run has started. 

• The Sample Interval (sec) field is used to indicate the frequency for which data points should be 
averaged in the Collection Fraction field of the Select Active Detectors dialog box (see Section 
3.2.5.1). Each averaged data point will be stored in the data file. In most instances, 1 sec is 
satisfactory. If the run is very long (e.g. > 45 min), a sample interval of 2 sec is used to reduce the 
number of points. This value cannot be changed after the run has started. 

• The Prestore Delay field is used to indicate the period of time after the start of the run before 
data should be collected. This feature is useful if there is a considerable period of time after 
injection before data of analytical utility is presented. This value cannot be changed after the run 
has started. 

• The Sample Conc (mg/ml) field is used to indicate the concentration of the sample.  

• The Sample Information fields are used to enter any information that the analyst would like to 
store with the data.  

• The Flow Rate, Injection Volume and Sample Concentration fields are used to enter the 
relevant parameters and are stored with the file. 

• The Mw Calc Type field is used to indicate if 15o data, 90o data or all data should be employed in 
the calculation. If desired, you can change the selection in Discovery32. 
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• The Mw Calc Method field is used to indicate the degree of smoothing (none, low, medium or 
high) that should be used in the calculation. If desired, you can change the selection in 
Discovery32. 

The Wait for Autostart Signal check box is used to indicate if the run should be started by an external 
signal (i.e. a contact closure from the chromatograph). If this box is not checked, the run is initiated by 
pressing the OK button. 

When the Run button is pressed, data collection is initiated. A typical chromatogram displayed in the 
workspace as shown in Figure 3-7. 

 
Figure 3-7:  Typical Chromatogram  

At the end of the run, the data will be stored and another run can be performed.  
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3.2.3.2 Multiple Runs 

Multiple Runs accesses the Multiple Runs dialog box (Figure 3-8), which is used to describe and 
program a series of automated data acquisition runs. 

 

Figure 3-8:  The Multiple Runs Dialog Box 

A run describes the collection of one or more chromatograms using a common set of conditions.  

To start a run, highlight the desired run set and press Start. As an example, if you selected the second run 
set, three injections would be made using the conditions indicated for the run set and would be named 
1.$00, 1.$01 and 1.$02. 

Multiple Run Files can be stored and loaded by the Save Multiple Run File and Retrieve Multiple Run 
File buttons.  

The Run Set parameters can be edited by the Multiple Run Information dialog box (Figure 3-9), which is 
accessed by clicking Edit. 
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Figure 3-9:  Multiple Run Information Dialog Box  

The Base File Name is used to indicate the file name that should be used for the data files. In the example 
shown in Figure 3-8, the data files would be collected would be testmix.$00, testmix.$01 and testmix.$02. 
All other parameters in this dialog box are identical to that for a single run (Section 3.2.4.1). 

The multiple run feature is commonly used in conjunction with an autosampler. In this mode of operation, 
the program will automatically collect, save and process the data. To initiate runs from the autosampler, 
place a check mark in the Use External Synch box on the Multiple Runs dialog box (Figure 3-8). 

The Fill (Figure 3-8) button is used to copy an edited line to other lines. To use this feature, highlight the 
line to be used as the template, then highlight the line(s) to which the edited line should be copied. The 
file which is used as the template must be above the line to be edited.  

3.2.3.3 End Run  

End Run stops the present run. When the run is stopped, all data collected up to that point in the run will 
be saved using the indicated file name. 

3.2.3.4 Silent Toggle  

The Silent Toggle button is used to display the most recently collected data file.  
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3.2.4 Review Menu 

The Review menu (Figure 3-10) is used to review collected data and start data collection. 

 
Figure 3-10:  The Review Menu 

3.2.4.1 Run Information 

The Run Information command is used to present a dialog box that includes the conditions for the last file 
that was opened (Figure 3-11). The information in this dialog box cannot be edited. 

. 

Figure 3-11:  Previous Run Information Dialog Box 

3.2.4.2 Start Discovery32  

Start Discovery32 transfers control of the system to Discovery32. A detailed discussion of Discovery32 is 
presented in Chapters 5-8.  

3.2.4.3 Display Detector Data 

Display Detector Data presents the chromatogram (Figure 3-7). 
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3.2.4.4 Show MW Calculations 

Show MW Calculations presents a plot of molecular weight data as a function of time (Figure 3-12).  

 

Figure 3-12:  Typical MW Chromatogram 

3.2.5 The Setup Menu 

The Setup menu (Figure 3-13) includes a number of commands that are used to establish instrument 
settings. In most instances, these are established when the unit is installed, but some settings can be set 
from time to time during operation. The top six commands are active for all systems and the bottom four 
are active only if the PD2000 DLS A/D Interface box is used. 
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Figure 3-13:  The Setup Menu 

3.2.5.1 Detectors 

The Select Active Detectors dialog box (Figure 3-14) is used to indicate the detectors that are used for the 
measurement, the collection fraction and temperature related data.  

 
Figure 3-14:  The Select Active Detectors Dialog Box 

Select the detector(s) that you want to use in this measurement by checking the check box(es) adjacent to 
the desired channels (the arrows are not valid in this release).  
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If you select Rh in the channel column, the Show Rh/Correlator data during acquisition check box will 
be activated.  

When a chromatogram is being presented, detector data will be indicated as a continuous curve in the 
chromatogram (e.g. Figure 3-7) and Rh data will be indicated as a step function in the bottom of the 
chromatogram.  

The Collection Fraction field is used to indicate the fraction of the data that is collected that will actually 
be used. This feature is used to minimize shot or random noise, as an example, if 0.50 is selected, the 
lowest 50% of the data that is collected will be used. For typical aqueous applications, a value of 0.10 is 
used, since the particles normally are large and for typical applications using organic solvents (e.g. THF), 
0.75 is recommended. The remaining data will be discarded.   

The Use as Temp Sensor check box is used if Temperature Rising Elution Fractionation is employed. In 
this mode, the temperature will be input into the spare channel. 

The Coefficients for Temp Conv. fields are used to enter the coefficients for the temperature sensor that 
are provided by the sensor manufacturer. 

The Collect Correlator data check box should be used if you want to collect data from the correlator . 

The Compute Mw check box should be selected if you want the molecular weight to be calculated. 

The Show Rh/Correlator data during acquisition check box should be checked if you want the Rh data 
presented when you are collecting data. 

3.2.5.2 Select Detectors for Display  

The Select Detectors for Display dialog box (Figure 3-15) is used to indicate the detectors for which 
output should be displayed during data acquisition and the detector for which the Y-axis is defined. If the 
data is not displayed, it is still being collected, if the detector is selected in Figure 3-15.  

 
Figure 3-15:  The Select Detectors for Display Dialog Box 
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3.2.5.3 Calibration 

The Calibration Setup dialog box (Figure 3-16) is used to enter calibration data and indicates how various 
calculations are to be performed.  

 
Figure 3-16:  The Calibration Setup Dialog Box 

Note: Low- and High-Angle detectors must be in place for this option to be valid. 

The "calibration constants" are the calibration values associated with your particular detector and are 
calculated after running an appropriate narrow standard of known molecular weight. These constants are 
then used in the molecular weight calculations of other samples in subsequent runs. 

These constants describe the physical parameters that of your specific system, for example, the solid 
collection angle of each detector, the power of the laser, etc., and are expressed as a single number for 
each calibration constant that is used in the calculation of molecular weight and radius of gyration. 

If the calibration values for the detectors are known, they should be entered. If not, you can ignore this 
box for the time being and run the calibration using a calibration standard and calculating the calibration 
constants via Discovery32. 

The Instrument Conc. Source and Run Conc. Source radio buttons are used to indicate the detector that 
is used to collect the data used for generating calibration data. If a Refractive Index detector is used, peaks 
can be both positive and negative. If both positive and negative peaks are observed in the chromatogram, 
the Invert Signal check box should be checked.  

The Mw Calc Type field is used to indicate the data that should be used for the calc (15 degree data only, 
90 degree data only and all data). Select the calculation type that will provide the best representation of 
the data for your particular application. The three calculation methods present a graph of the differential 
distribution of molecular weight.  

Note: Low and High-Angle detectors must be in place for the all data option to be valid. 
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The Mw Calc Method field is used to indicate how the data should be processed. There are five MW Calc 
Methods (No smoothing, Low smoothing, Medium smoothing, High smoothing and GPC polynomial 
smoothing). 

Note: Low- and High-Angle detectors must be in place for this option to be valid. 

If you have any questions about the best treatment of your particular sample, please consult Precision 
Detectors. 

Precision Detectors software determines the molecular weight distribution by first calculating the 
molecular weight at each slice. From these results, a column calibration curve is created that plots the 
molecular weight as a function of the elution time. The molecular weight distribution is then determined 
using this curve and the concentration chromatogram. 

The smoothing options are provided to reduce the noise that is sometimes observed at the extremities of 
the Mw vs. Elution time curve (where the chromatographic signals are relatively weak). 

The "smoothing function" takes the Fourier Transform of the signal, multiplies it by the high frequency 
cutoff smoothing function, and then takes the inverse Fourier transform. 

3.2.5.4 Configure System 

The System Configuration dialog box (Figure 3-17) is used to establish the communication parameters 
between the detector and the computer and indicate the location of the data directory as well as the 
calibration file.  

 

Figure 3-17:  System Calibration Dialog Box 
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The Comm Port, Baud Rate and Stop Bits field should be set as described in Section 2.4.6. The desired 
Data Directory and Calibration File should be selected by pressing the Select button and then choosing 
the directory.  

The Calibration file provided with the system should normally be used. This file optimizes the interface 
box (not the optics bench) and its file name matches the serial number on the PD2000/DS box.  

If an external interface box is used, the Disable Calibration File Loading box should be checked. 

The PD2000 Compatibility Mode check box is used to allow for backward compatibility in data 
acquisition 

The Use DTR/DSR check box is used to enforce more rigorous communication between the computer and 
the A/D box. 

The Correlator daughter board present check box is used to indicate whether a PD2000DLS box ( which 
has a correlator board) or a PDConnect box ( which does not have a correlator board) is used. This 
prevents PrecisionAcquire32 from posting erroneous dialog boxes or searching unnecessarily for 
correlator boards that do not exist. 

Typically, all three check boxes at the bottom of the dialog box should be selected.  

3.2.5.5 Analog Board Setup Dialog Box 

The Analog Board Setup dialog box (Figure 3-18) is used to enter parameters that control the analog 
board.  

 
Figure 3-18:  Analog Board Setup Dialog Box 

The Sample Rate should be set to 100 Samples/sec except in regions of Japan where the line frequency is 
90 Hz. 

The Request Hardware to send a start signal now check box is an unimplemented feature. Uncheck this 
box. 

The Ignore Autostart signals sent while acquisition is in progress check box is used to prevent data 
acquisition from prematurely stopping if such a signal is sent. 
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3.2.5.6 Export Options Dialog Box 

The Export Options dialog box (Figure 3-19) is used to select the format for data export.  

 

Figure 3-19:  Export Options Dialog Box 

If you want the data exported into a format that can be employed with PLGPC, Viscotek software or in 
ASCII format, place an x in the appropriate check boxes, and indicate the format for PLGPC format. The 
data will be stored in the appropriate directory. 

3.2.5.7 Correlator Configuration 

The parameters on the Correlator Configuration dialog box should not be changed by the user. 

3.2.5.8 Correlator Analysis 

The Correlator Analysis Setup dialog box (Figure 3-20) is used to set a variety of run parameters.  
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Figure 3-20:  Correlator Analysis Setup Dialog Box  

For typical operation:  

a) Deselect the Special Store correlator raw data in *.znn box. These files are not necessary for 
saving as the Rh data is saved in the *.$xx files. The *.Znn files are large and waste unnecessary disk 
space. 

b) Set the Viscosity and Refractive Index to that for the temperature and solvent that will be used for 
the measurement. 

c) Set Lambda to 800.0, Tolerance 1 to - 0.001 and Tolerance 2 to 0.1. 

d) Select Corr should be set to 1. 

e) Base Type should be set to Linear Fit. 

3.2.5.9 Readback Status Dialog Box 

The Readback Status dialog box (Figure 3-21) is used to ensure that the settings on the Setup Correlator 
and Correlator Analysis Setup dialog boxes have been successfully downloaded to the box. 
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Figure 3-21:  Readback Status Dialog box 

When this dialog box is opened, check that the parameters in the Readback column correspond to the 
values that were entered on the previous dialog boxes. If the values are identical, click OK. 

Note: It is important to open this box and verify that the parameters that were made, as changes in Figure 
3-19 are not saved until the OK button on the Readback Status dialog box has been pressed.  

3.2.5.10 AutoIntegration 

The Autointegration dialog box (Figure 3-22) is used to indicate the desired integration parameters. 

 
Figure 3-22: The Auto Integration Setup Dialog Box 
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The fields in this dialog box can be used to calculate molecular weight in real time, the settings are not 
carried over to Discovery32. 

3.2.6 The Monitor Menu 

The Monitor menu (Figure 3-23) is used to view/control the status of the laser, data display and other 
components of the system. 

 
Figure 3-23:  The Monitor Menu 

3.2.6.1 Dump Commands  

The Dump Commands command is reserved for service.  

3.2.6.2 Monitor Photon Level 

The Monitor Photon Level command presents the current laser output (Figure 3-24).  

 
Figure 3-24:  Laser Level 

The Laser Output level is dependent on the Rayleigh ratio and the degree of cleanliness of the 
solvent. The range is typically between 20,000 and 100,000. Aqueous based solvents such as water or 
phosphate buffered saline will have background counts of approximately 30,000, methanol and THF 
will have background counts of 40,000 and high scattering solvents such as TCB will have even 
higher values. If the level is outside that range, contact Precision Detectors. 

3.2.6.3 Stripchart 

The Stripchart command accesses the Stripchart Setup dialog box (Figure 3-25), which is used to set 
the size of the display for data collection 
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Figure 3-25:  The Stripchart Setup Dialog Box 

Enter the Y range and the X range as well as the Sample Interval.  

The Fixed period selection will present a recording for the time indicated in the Xwidth field and will not 
present data collected after the indicated time. The data will continue to be collected and saved. 

The Scrolling selection will present a recording for the time indicated in the Xwidth field and will redefine 
the X-axis on the strip chart when the Xwidth time is reached so that a continuous presentation is 
obtained.  

The Sample Interval field is used to indicate the frequency that the plot is updated. The data will be saved 
using the value entered in the Single Run Info dialog box (Figure 3-5). 

When you press OK, the monitor presents a display of the grid that will be used to present data       
(Figure 3-26) and a dialog box that you can use to edit the box. 
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Figure 3-26:  Strip Chart Display 

The Stripchart Y-axis Limits dialog box is used to change the display while data is being collected. 

3.2.6.4 Laser 

The Laser command turns the laser on/off. When the laser is on, a checkmark appears adjacent to the 
legend and a small green light on the status line is illuminated. 

Note: If you turn the laser off and on again, it will take approximately 15 to 30 minutes for the system to 
stabilize. 

3.2.7 Help 

The Help menu (Figure 3-27) accesses information to assist in the operation of the system. 

 
Figure 3-27:  The Help Menu 
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About PrecisionAcquire presents a dialog box that includes the version number and copyright information 
for the program. 

Get Board Version accesses a dialog box that indicates the version of various printed circuit boards inside 
the connector box. The information in this dialog box is not related to routine use of the system but may 
be of assistance in troubleshooting. 

Help accesses the PrecisionAcquire help file, which provides on-line assistance. 

3.3 THE TOOL BAR 

The Tool Bar (Figure 3-28) provides rapid access to a variety of commands that are commonly used in 
PrecisionAcquire32.  

 

Figure 3-28:  The Tool Bar 

 is equivalent to New on the File menu (which is inactive). 

 accesses the Open dialog box (is equivalent to Open on the File menu. 

 equivalent to Start Single Run on the Single Run Info dialog box (Figure 3-5). 

 accesses the Multiple Runs dialog box starts (equivalent to Multiple Runs on the Acquire menu). 

 accesses the Select Detectors for Display dialog box (equivalent to Display on the Setup menu). 

 accesses the Calibration Setup dialog box (equivalent to Calibration on  the Setup menu). 

 accesses the Select Active Detectors dialog box (equivalent to Detectors on the Setup menu). 

 accesses Discovery32 (equivalent to Run Discover32 on the Review menu). 

 accesses Discovery32 so that you can work with stored data during a run  (equivalent to Silent 
 Mode on the Acquire menu). 

 prints the current display in the workspace (equivalent to Print on the File menu).  

 presents the About PrecisionAcquire dialog box, which includes the version number (equivalent 
 to About PrecisionAcquire on the Help menu). 
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 stops the present run (equivalent to End Run on the Acquire menu). 

 terminates the restore process and lets you collect data.  

 shows the present detector data. 

 shows molecular weight data.  

 turns laser on/off. 

3.5 WORKSPACE 

The Workspace is used to display the chromatogram as it is being collected. A typical chromatogram is 
shown in Figure 3-30. 

 
Figure 3-30:  A Typical Chromatogram 

In a chromatogram, detector outputs are indicated as normal traces and molecular weight outputs are 
indicated as step functions. 
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3.6 THE STATUS BAR 

The Status Bar (Figure 3-31) presents the status of the system and provides information about the file that 
is open.  

 

 
 

Figure 3-31:  The Status Bar 

The leftmost field indicates the present status of the system. If you click on a command on the Menu bar, 
the status field will indicate the role of the command (i.e. if you click on Multiple Runs, the message 
Setup and Start Multiple Runs is presented. 

File Name 

Time elapsed in the chromatogram and overall time of the run.   

Communication Status - green icon indicates that the detector is communicating with the 
computer 

Laser Lock Status - green is on 

Laser Status - green is on 

Status Status 

Elapsed Time 

Communication Status 

Laser Lock Status 

Laser Status 
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Chapter 4 

Selecting Parameters for Data Acquisition with 
PrecisionAquire32 
 

4.1 OVERVIEW 

PrecisionAcquire32 provides the user with a great deal of flexibility in the selection of parameters for 
light scattering measurements. Many of these parameters (e.g. the Collection Fraction and the Smoothing 
Option) can be adjusted by the operator to optimize and automate the collection of the analytical results.  

Note: This discussion assumes that the user has optimized the chromatographic separation and the 
compounds of interest are well resolved. 

The user is encouraged to experiment with the parameters described below to determine the effect of 
small changes in the analytical results. These experiments should be performed on a controlled basis. In 
these experiments, parameters that describe physical properties of the sample (e.g. temperature and 
refractive index) should not be altered.  

This chapter describes how to select the value for several parameters to assist in optimize the results from 
the detector and describe the various tradeoffs that are made. 

4.2 PARAMETERS THAT AFFECT THE NOISE  

Since light scattering is extremely sensitive to microparticulates sloughing off a column or dissolved in 
the eluant, it is an inherently noisy measurement if the proper operating procedures are not followed 
PrecisionAcquire32 and Discovery32 include a number of parameters that can be used to minimize the 
noise in the chromatogram. While data is being collected on a continuous basis; the system integrates and 
then stores the data at the frequency indicated in the Sample Interval field on the Single Run Info dialog 
box (Figure 3-5); a typical value for this parameter is 1 sec.  

The parameters in PrecisionAnalyze32 that affect the noise in the chromatogram when static light 
scattering is employed include: 

• Collection Fraction (Select Active Detectors dialog box) - Section 4.3.1 

• Sample Interval (Single Run Info dialog box)- Section 4.3.2 

• MW Calc Method (Single Run Info and Calibration Setup dialog boxes) - Section 4.3.3 
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The parameters in PrecisionAnalyze32 that affect the noise in the chromatogram when dynamic light 
scattering is employed include: 

• Run Time (Correlator Configuration dialog box) - Section 4.4.1 

• Sample Time (Correlator Configuration dialog box) - Section 4.4.2 

• Tolerance 1 and Tolerance 2 (Correlator Run Setup dialog box) - Section 4.4.3 

The parameters in PrecisionAcquire32 are stored with the data and cannot be changed after data 
acquisition. The operator can choose a smoothing factor to be used on stored data in Discovery32 (Section 
6.4) and readily determine the effect changing of the smoothing factor on the chromatogram. This 
suggests that the user would be wise to select smoothing conditions in PrecisionAcquire32 that are good 
but less than ideal, since additional smoothing can be performed in Discovery32. If “ideal smoothing 
conditions” are selected in PrecisionAcquire32 and the analyst wants to see a feature in the chromatogram 
in Discovery32, it might be necessary to re-run the separation and collect data again. Unless the 
methodology is fully characterized, it is safer to select No Smoothing in PrecisionAcquire32 and post 
process the file later with Discovery32. 

The nature of the smoothing factor is dependent on the type of macromolecule that you are investigating 

• Discontinuous distributions (e.g. Proteins) involve cases where the main peaks or the multiple 
peaks contain single size macromolecules with impurities of other sizes. Smoothing routines 
other than the polynomial fit are typically used to study these distributions.  

• Continuous distributions involve a broad range of macromolecular species (e.g. polymers 
synthesized via a Condensation polymerization or free radical polymerization). The polynomial 
fit is aimed to study these 2 distributions. 

4.3 PARAMETERS FOR ALL SYSTEMS  

4.3.1 The Collection Fraction 

During the sample interval, a large number of readings are made. The difference in the intensity between 
individual readings is fairly large due to the randomness of the measurement. The Collection Fraction 
field on the Select Active Detectors dialog box (Figure 3-12) is used to indicate the fraction of the data 
points to be used to generate a data point. In each case, the readings with the lowest intensity in the time 
interval are used to minimize signals that are especially large. As an example, if 75% is selected, the 
system uses 75% of the readings and selects those readings that are the lowest in intensity to generate the 
data point as shown in Figure 4-1. 
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Figure 4-1:  Use of Collection Fraction  

There is a tradeoff in the selection of the Collection Fraction; if a large value is selected, the intensity of 
the data point will be higher but the chromatogram will be noisy. Similarly, a small value for the 
Collection Fraction will lead to less noise and a smaller signal. In Figure 4-1 we present chromatograms 
that were taken with the same sample using collection fractions of 0.1 and 0.75. 

Typically, a collection fraction of 0.10 is used for aqueous samples and 0.75 is used for samples dissolved 
in organic solvents such as THF. 

4.3.2 Sample Interval  

The Sample Interval field on the Single Run Info dialog box is used to indicate the frequency of collection 
of data points. Typically a 1 sec value is selected; if the chromatogram is long (e.g.> 45 min), a value of 2 
sec is acceptable if you want to reduce the number of points. A small value will provide better 
chromatographic resolution, but may increase the noise in the chromatogram and will significantly 
increase the size of the data file and increase the time for processing.  

If desired, you can reduce the number of data points by indicating a Prestore Delay. When a Prestore 
Delay is indicated, data will not be collected for the indicated period of time (i.e. if the peaks of interest 
elute in the region from 25.00 min to 32.00 min, you can enter a 14.00 min prestore and reduce the file 
size; thus allowing for a smaller sample interval. 

By increasing the time for each point we can get better signal to noise. As an example if you select 100 
points per second at 75% collection rate, 75 points will lead to one point per second, if you set the interval 
to 2 point every second then we get fewer data points. The latter case will give a more stable baseline, 
however it should be noted that if the interval were too large, the rise time of the chromatogram would be 
affected. 

4.3.3 MW Calc Method 

The MW Calc method field on the Single Run Info and the Calibration Setup dialog boxes is used to select 
the degree of smoothing. This selection refers only to the smoothing of the molecular weight trace on the 
chromatogram as the data is presented in the workspace. The actual raw data is stored in the data file and 
is not affected by the smoothing. It is recommended that this field be set to No Smoothing for most cases, 
especially when polymers are used; and polynomials should be used for synthetic polymers, where there 
is a true distribution.  
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4.4 PARAMETERS FOR PD2000 SYSTEMS 

4.4.1 Run Time  

The Run Time is the amount of time over which the correlation function calculation is averaged. Typically 
a run time of 10 sec is used. This parameter is used only with DLS systems. If the Run time is decreased, 
the correlation may become noisier and if the run time is increased, fewer points for the correlation will 
be collected.  

4.4.2 Sample Time  

The sample time is the time for collection of a single data point for use in the correlation function. 
Typically a value of 5 µsec is used; if the weight is greater than 1000 kD, the sample time should be 10 
µsec. 

4.4.3 Tolerance  

"Tolerance 1" requires that the slope of the linear fit to the log of the correlation function to be less than -
0.001. If the correlation function has a slope greater than what is set for Tolerance 1, that value is not used 
in the hydrodynamic radius calculation (i.e., noisy data are thrown out).   

"Tolerance 2" compares the absolute value of the error of the measurement to the absolute value of the 
slope; if the ratio of the two values is less than 0.100 the data is accepted for the calculation. 
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Chapter 5 

Introduction to Discovery32 
 

5.1 OVERVIEW 

Discovery32 is used to process data collected from Precision Detectors Light Scattering Detectors using 
PrecisionAcquire32. The program is used to display chromatograms, determine the molecular weight 
(molecular weight average) of polymers, generate reports and overlay data from multiple runs. In 
addition, it is used to determine the molecular size by dynamic light scattering and determining the radius 
of gyration by 2 angle light scattering.. 

This chapter describes the Main window of Discovery32 (Figure 5-1), which is used to coordinate all 
activities of the application program, access a variety of tools to process and present data. A discussion of 
the use of these commands in a typical scenario for protein analysis is presented in Chapter 6, and a 
typical scenario for synthetic polymer analysis is presented in Chapter 7.  

 
Figure 5-1:  The Main Window 
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The Main window includes the following regions: 

• the Menu Bar, which is used to access a broad range of commands (Section 5.2). 

• the Tool Bar, which provides shortcuts to a number of commonly used commands (Section 5.3). 

• the File Access and File Selection regions, which is used to open a file (Section 5.4). 

Note: The commands in a menu, the icons on the tool bar and the options in various dialog boxes that are 
active at a given point depend on the present status of the program (e.g. the Save command is not active 
unless one or more files are open). In this chapter, we will describe each command and indicate when it is 
active. At a given instant, commands/options that are selectable will indicated in the menu in black, while 
inactive commands/options will be indicated in gray. In this manual, all options will be indicated in black 
for the sake of clarity.  

5.2 THE MENU BAR  

The Menu bar includes the following drop down menus (the menu bar is active after a file has been 
opened):  

5.2.1 The File Menu 

The File menu (Figure 5-2) includes a number of commands that relate primarily to archival activities and 
printing of files.  

 
Figure 5-2:  The File Menu 



 

Discovery32 - Chapter 5  5-3 

5.2.1.1 Open 

Open presents a dialog box that lists the files in the indicated folder. Discovery32 uses binary files from 
the appropriate data acquisition program, and have the format xxxxxxxx.$xx (e.g. ABCD1234.$33). 

5.2.1.2 Save As 

Save as presents a dialog box that is used to assign a new name to the file. Files are saved in the binary 
file format with the name xxxxxxxx.$xx. 

5.2.1.3 Export  

Export presents the Export dialog box (Figure 5-3), which is used to export data in ASCII format, 
Polymer Laboratory Single Channel or Double Channel format or Viscotek format so that the data can be 
employed with the corresponding data processing programs.  

 
Figure 5-3:  The Export Window 
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To export files: 

a) Press the Select Files for Export button to present a dialog box similar to the Open command. 

b) Select the desired file(s). 

c) Select the desired format(s) by placing a check in the desired checkbox. 

d) Select the desired file type by clicking on the appropriate radio button. 

e) Indicate the directory in which the file should be stored by pressing the Select button for the desired 
file type. 

f) Press OK. 

The files will be exported to the indicated folder, with the following suffixes: 

ASCII - xxxxxxxx.Axx 

PLGPC – this feature is not yet operational 

Viscotek - xxxxxxxx.vdt. A file can contain up to 1600 data points. If the file contains more than 
1600 data points, the operator will be given the option to truncate the file.  

A detailed discussion of the export format is presented in Chapter 9. 

5.2.1.4 Create Report Layout 

Create Report Layout presents the ReportLayout window (Figure 5-4), which is used to define the 
general layout of the report. A detailed discussion of the report feature is presented in Chapter 9. 

 
Figure 5-4:  Report Layout Window 
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5.2.1.5 Set Default Report Layout 

Set Default Report Layout  presents an Open dialog box to allow the selection of the desired report 
layout. Report layouts are of the form ********.rlo, and are normally stored in the same directory as the 
data. When you open a layout, the name of the selected layout is indicated directly below the loaded file 
name (see Figure 5-1). 

5.2.1.6 Display Options  

Display Options – presents the More Report Options dialog box (Figure 5-4), which allows the operator 
to indicate the company name and if the information indicated by the check boxes should be indicated on 
the report.  

 
Figure 5-4:  The More Report Options Dialog Box 

5.2.1.7 Print  

Print presents the Print Setup dialog box, which is a standard Windows dialog box to select the printer, 
paper size and orientation for printings. The format of this dialog box is dependent on the selected printer. 

5.2.1.8 Print Setup 

Print Setup presents the Print dialog box, which is used to select the printer, the print range and the 
number of copies to be printed. The format of this dialog box depends on the printer attached to the 
computer. 

Recently open files are indicated at the bottom of the File menu. You can open a file by clicking on the 
desired entry. 

5.2.2 View  

The View Menu includes the following commands: 

• Toolbar - presents the tool bar (Section 5.3). 

• Status Bar - presents information about the present state of the program on the bottom line of the 
display (see Figure 5-1). 

To select/deselect either (both) option, click on the command, if the options is selected, a check mark will 
be indicated to the left of the command. 
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5.2.3 Options  

The Options menu (Figure 5-5) includes a number of commands that relate collection and presentation of 
data. 

 
Figure 5-5:  The Options Menu 

5.2.3.1 Chromatograms 

Chromatograms presents the Chromatograms dialog box (Figure 5-6) which displays the 
chromatogram(s) in the selected file. Figure 5-6 includes data from an RI detector as well as from 15o and 
a 90o angle light scattering detectors (the arrows indicate the integration region, which is set as described 
below. The chromatogram can be zoomed by clicking on a corner and dragging the mouse.  

There are four tabs in this dialog box: 

 
Figure 5-6:  The Chromatogram Dialog Box  
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a) The Operate on Chromatogram tab is used to perform a number of basic chromatographic data 
processing operations such as setting the baseline, normalize the chromatogram, etc, which are 
accessed by right clicking on the chromatogram (Figure 5-7). 

 
Figure 5-7:  Chromatogram Operations Menu 

Set Baseline 

The baseline start and finish are indicated by open and close brackets on the chromatogram (e.g. at 2.0 
and 2.5 min on Figure 5-6). 

To set the baseline:  

a) Click on Set Baseline to present the Select Detectors dialog box (Figure 5-8) 

 
Figure 5-8:  Select Detectors (Baseline Correction) Dialog Box  

b) Select the desired Baseline Type and indicate the detectors for which the baseline should be 
subtracted. After you click OK, a pair of vertical lines may appear on the chromatogram if the 
chromatogram was processed previously (Figure 5-9).  
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Figure 5-9:  Chromatogram with Baseline Markers 

c) Indicate the position of the baseline by clicking on the vertical line and dragging it to the desired start 
(finish) of the baseline. The black lines on the chromatogram indicate the selected baseline. 

Note: There are a number of ways of defining the baseline. The above example involves the use of a 
baseline drawn by exponential skim, which is useful good for extrapolating a baseline if the front or tail 
end of the chromatogram lacks a flat region for selection. As an alternative, you can select a portion of the 
baseline before and after the peak. For a point-to-point baseline, simply select a start and finishing point 
for baseline determination. 

You can define the baseline by clicking on the vertical line and dragging it to the desired start (finish) of 
the baseline. The black lines on the chromatogram indicate the selected baseline. A least squares baseline 
can be made to perform like a point-to-point baseline by selecting a baseline [region] before and after the 
peak.) 

Set Integration Region 

The Set Integration Region start and finish are indicated by up and down arrows on the chromatogram 
(e.g. at 12.0 and 23.5 min on Figure 5-9). These can be moved in the same manner as the baseline 
markers by holding the Ctrl button down and dragging the up and or the down arrows on the 
chromatogram using the left mouse button. If the integration region has not been previously selected (as 
would be the case for a unprocessed data file), the start and stop positions are determined by selecting 
integration and then dragging the left mouse from the start to the stop positions 
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Set as Integration Template 

When you set the integration region as described above, the region will be used only with the active 
chromatogram. If you want to use this region for other chromatograms in the present study, select Set as 
Integration Template (to avoid having to set the integration region for each chromatogram). A message 
box will be presented, indicating that the template was established.  

Show Chromatograms displays the active chromatogram. 

Show Raw Chromatograms displays the chromatogram before smoothing, etc. 

Normalize Chromatogram presents all traces on a common set of axes, with the largest peak full 
scale. Baselines need to be established to use this feature effectively. 

Normalize Region Once baselines have been determined, the normalize region is a useful feature that 
will height normalize based on apex and baseline of a peak that are found in a selected region. The 
lines are similar to those used to define the baseline, and can be dragged to define a region to be 
normalized. The largest peak in the selected region will be presented full scale and all points in the 
region will be normalized to it. 

Note: Show Chromatograms, Show Raw Chromatograms, Normalize Chromatogram and Normalize 
Region are toggle commands; when one is selected, it replaces the existing selection. 

Shift Print prints out the chromatogram. 

Raw Data Table presents a list of points with the time and intensity for each detector, which can be 
copied or saved. This table includes the entire range of the chromatogram. 

Reduced Data Table presents a list of points that lie within the integration region (up and down 
arrow) and includes the value of Ai. The list can be saved or printed. 

5.2.3.2 Integration Method 

The Integration Method tab is not active. 

5.2.3.3 Autointegration 

The Autointegration tab (Figure 5-10) is used to list the files that are to be integrated on an automated 
basis. You can include files by selecting the Add Files to List button, and then choosing the desired files 
via the Open dialog box that is presented. 

     5 



 

5-10  Discovery32 - Chapter 5 

 
Figure 5-10:  The Autointegration Tab 

After you have selected the desired files, press the Auto-Integrate Using >>> button. The data in each file 
will be integrated using the template indicated adjacent to the button (this file was selected in the Operate 
On Chromatogram tab (Section 5.2.3.1)). 

5.2.3.4 Raw Data Transformation 

The Raw Data Transformation tab is identical in format to the Chromatogram dialog box (Figure 5-6), 
and can be used to smooth the chromatogram and invert the RI chromatogram. When the right mouse 
button is pressed, the menu shown in Figure 5-11 is presented. 

 
Figure 5-11:  Raw Data Transformation Menu 
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Chromatogram Smoothing 

Note: Chromatogram smoothing is used to reduce noise and random variations in the chromatogram. The 
analyst should note that small peaks, which may be of analytical use may also be reduced, so some 
caution should be used with this function. 

When Chromatogram Smoothing is selected, the Chromatogram Smoothing dialog box (Figure 5-12) is 
presented. 

 
Figure 5-12:  The Chromatogram Smoothing Dialog Box 

The check boxes are to indicate the detector traces that are to be smoothed and the Smoothing Degree 
radio buttons indicate the desired level of smoothing. It is possible to change the smoothing in several 
formats and process each file individually. 

Invert RI Chromatogram 

The Invert RI Chromatogram command is used to change the format of each data point in the RI 
chromatogram. Points, which are above the baseline, are below it and vice versa. The numerical deviation 
from the baseline remains constant (i.e. if the baseline is 150 mV and a peak is at 200 mV, it will be at 
100 mV after the command is performed). 

Save Operated Chromatogram 

When a chromatogram that has been altered via any command is to be saved, it will be saved with the 
letters OP after the name (e.g. If PDI.$07 is altered and saved, it will be saved as PDIOP.$07). If 
additional operations are performed, the operated file is this process will continue (e.g. PDIOP.$07 
becomes PDIOPOP.$07). The original raw data file is never lost in this process. 
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5.2.4 Setup Calculation 

The Setup Calculation dialog box (Figure 5-13) is used to enter various parameters for calibrating the 
system. 

 
Figure 5-13:  The Setup Calculation Dialog Box - Options Tab 

5.2.4.1 Options Tab 

The Options tab (Figure 5-13) is used to indicate the type of calculations to be used, the degree of 
smoothing and the laser used. 

5.2.4.2 Detectors  

The Detectors tab (Figure 5-14) is used to indicate the detectors for which data should be displayed and 
radio buttons to indicate the axes legend. 
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Figure 5-14:  The Setup Calculation Dialog Box - Detectors Tab 

5.2.4.3 Constants 

The Constants tab (Figure 5-15) is used to indicate a series of instrumental constants.  
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Figure 5-15:  Setup Calculation Dialog Box  

5.2.4.4 Determine Cal Constants 

The Determine Cal Constants tab is used to enter calibration parameters, calculate the cal constants and 
accept them. A detailed discussion of the calibration process is described in Chapter 6 (for monodisperse 
polymers) and Chapter 7 (for polydisperse polymers). 

5.2.5 Results 

The Results dialog box presents a series of tabs that present calculated information. 

5.2.5.1 Summary 

The Summary tab (Figure 5-16) presents an overview of the analysis and the information is dependent on 
the nature of the analysis. The analyst can edit the data in the Run Information fields.  
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Figure 5-16:  The Results Dialog Box - Summary Sheet 

5.2.5.2 Run Params Tab 

The Run Params tab (Figure 5-16) is used to check the calibration results for RI/LS , UV/LS and batch 
/LS MW calculations. Mw for batch is entered manually and is selected by a check box in the 
concentration detector section. It is used to cross check entered vs. calculated dn/dc, UV extinction 
coefficients and concentration. 
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Figure 5-16:  The Results Dialog Box - Run Params Tab 

5.2.5.3 Distribution Tabs 

The Results dialog box presents a series of tabs that describe the distributions (Mw Distribution, Rh 
Distribution, Rg Distribution). The format of these distribution tabs is similar, and those tabs that are 
active depends on the selection(s) that were made on the Options tab of the Setup Calculations dialog box 
(Section 5.2.4.1). 
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Figure 5-17:  The Results Dialog Box - MW Dist Tab 

The menu shown in Figure 5-18 is accessed by right clicking on the MW Dist tab. 

 
Figure 5-18:  MW Dist Tab Commands 

Plot Limits presents the Set Plot Limits dialog box (Figure 5-19), which is used to indicate the desired 
limits for the plot. 
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Figure 5-19:  The Set Plot Limits Dialog Box  

If Show Result Values is checked, the results values will appear in the upper right corner of the plot as 
shown in Figure 5-18. 

If Show polynomial fit coefficients is checked, a curve fit can be generated along with the polynomial fit 
equation.. 

If Connect points with lines is checked, the data points will appear as shown in Figure 5-18. If it is not 
checked, only the data points will be presented. 

{Shift} Print is used to generate a hard copy of the plot. 

Cumulative Off is used to turn off the cumulative Mw trace on the plot. When the cumulative trace is off, 
the command will indicate Cumulative on. 

Data Table presents a table containing the molecular weight, the corresponding ordinate value and the 
cumulative ordinate value for each data point. The table can be copied or saved as desired.  

5.2.5.4 Elution Tabs in the Results Dialog Box 

The Results dialog box presents a series of tabs that describe the calculated parameter as a function of the 
elution time distributions (Mw Distribution, Rh Distribution, Rg Distribution). The format of these 
distribution tabs is similar, and those tabs that are active depends on the selection(s) that were made on 
the Options tab of the SetupCalculation dialog box (Section 5.2.4.1). A typical plot, for Mw vs. Elu is 
shown in Figure 5-20. 
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Figure 5-20:  Results Dialog Box – Mw vs. Elu Tab 

The menu shown in Figure 5-21 is accessed by right clicking on the MW Dist Tab (not all commands are 
present for all tabs). 

 
Figure 5-21:  Elution Tabs Commands 

Plot Limits and {Shift Print} are the same as in Section 5.2.5.3. 

Display Setup presents the Display Setup dialog box (Figure 5-22), which is used to indicate which traces 
should be presented.  
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Figure 5-22:  Display Setup Dialog Box 

Correlator Info presents the Correlator Information dialog box (Figure 5-23), which is used to enter 
information about the sample in the correlator (Rh vs. Elu tab only).  

 
Figure 5-23:  Correlator Information Dialog Box 

Polynomial Fit Setup presents the Polynomial Setup dialog box (Figure 5-24), which is used to define the 
fit (Rg vs. Elu tab only).  

 
Figure 5-24:  Polynomial Setup Dialog Box 

If you select Fitting Enabled, fitting will be performed based on the parameters indicated for the 
Polynomial Order, the Left Fit Limits and the Right Fit Limits.  

If you select Show Fit, the equation describing the Rg fit will be indicated on the tab. 
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5.2.5.5 GPC 

The GPC command is used to determine the GPC distribution and obtain the best results for the fit. When 
the GPC icon is selected, the GPC window (Figure 5-25) is presented.  

 
Figure 5-25:  The GPC Window 

To establish a calibration curve: 

a) Right click to access the pop-up menu shown in Figure 5-26. 

 
Figure 5-26: The GPC Popup Menu 

b) Select Narrow Standard Info Setup to present the Narrow Standard Table Options dialog box, 
which is used to select the data to be used for the calculation. 

     5 



 

5-22  Discovery32 - Chapter 5 

 
Figure 5-27:  Narrow Standard Table Options Dialog Box  

c) Select Add Narrow Standard Information from the pop-up menu to present a table that presents the 
calibration data obtained from the chromatogram (Figure 5-28). A point will be presented for each 
peak in the chromatogram.  

 
Figure 5-28:  Narrow Standard Information 

d) Close the Narrow Standard Information dialog box to present a plot containing the points indicated in 
the table.(Figure 5-29). Drag the blue line from the left axis to set the polynomial fit. If you drag the 
line all the way to the right, all data points will be included. The plot will include the equation for the 
calibration line as shown in Figure 5-30. 
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Figure 5-29:  Calibration Plot  
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Figure 5-30:  Calibration Plot with Equation  

e) If desired, you can add more data points to the calibration curve by selecting Data Table on the pop-
up menu and adding Time/Molecular weight points manually. When you have completed adding 
points, close the data table to view the updated calibration table.  

f) When the calibration curve is acceptable, save the table by selecting Save Table and assigning a file 
name (files are saved as *******.gpc). The legend above the calibration plot will indicate the 
complete path and file name (e.g. PDI\samples\123.gpc). 

To employ the calibration curve to obtain molecular weight data: 

Once the calibration curve has been generated (or recalled), you can obtain analytical data from the 
selected data file by opening the Conventional GPC Distributions tab. A typical presentation is shown in 
Figure 5-31; the calculated molecular weight data is presented in the upper right hand corner. A popup 
menu is provided, which can be used to set Plot Limits, Print the plot, present the Cumulative plot and 
present the data table in the normal manner. 
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Figure 5-31:  Conventional GPC Distributions Tab 

5.2.5.6 Branching 

The Branching command presents the Branching dialog box, which includes a series of tabs for 
presentation of the data as Rg vs. Mw, Rh vs. Mw, g Mw Branching, g Rg Branching and Rg/Rh 
Branching plots.  

The right mouse button presents a menu describing the actions on the displayed data. The is similar to 
Figure 5-21, with the exception that the Polynomial Fit Setup command presents the Fit Data Setup 
dialog box (Figure 5-32). 
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Figure 5-32:  Fit Data Setup Dialog Box  

5.2.5.7 Overlay Select 

The Overlay Select command presents the Set Up Overlays dialog box (Figure 5-33), which is used to 
chromatograms that should be displayed in the chromatogram field. 

 
Figure 5-33:  The Set Up Overlays Dialog Box 

You can select the chromatograms to be displayed by clicking on the select box, then selecting the 
chromatogram what you want to show  
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5.2.5.8 Update Acquire32 Constants  

This command, which is on the Options menu, is used to transfer the calibration constants that 
you have developed via Discovery32 to PrecisionAcquire so that they can be applied as data is 
acquired. 

5.2.6 Help 

The Help menu (Figure 5-34) includes two commands: 

 
Figure 5-34:  The Help Menu 

• Help accesses an on-line help system 

• About Discovery32… presents a dialog box that includes copyright information and the version 
number. 

5.3 THE TOOL BAR  

The Tool bar (Figure 5-35) is used to present a series of shortcuts for some commonly used commands. 

 
Figure 5-35:  The Tool Bar 

 equivalent to Open on the File menu 

 equivalent to Save on the File menu 

 equivalent to Print on the File menu 

 accesses the Data Acquisition program 

 equivalent to Chromatogram on the Options menu 

 equivalent to Set Up Analysis on the Options menu 

 equivalent to Results on the Options menu 
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 accesses the GPC dialog box  

 accesses the Branching and Structure dialog box 

 equivalent to Overlay Select on the Options menu. 

5.4 THE FILE ACCESS AND FILE INFORMATION REGION 

The File Access region (Figure 5-36) is used to present information about the various files that are in a 
given directory. 

 
Figure 5-36:  The File Access Region 

The File Access region is used to access all of the chromatograms in a given folder and sort the file 
presentation list (Section 5.6). To select the folder that contains the files of interest. 

a) Click on Change >>> to present Figure 5-37. 

 
Figure 5-37:  The Browse for Folder Directory 
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b) Select the desired folder in the standard Windows approach. The files in the folder will be presented 
in the File Selection region (Figure 5-38). 

 
Figure 5-38:  The File Information Region 

You can select a file to be the active file by clicking on it (e.g. BSA.$12). The chromatogram for that file 
will appear on the right side (e.g. Figure 5-1). 

The file information region contains the following information (accessed via the slide bar). 

• File Name  

• Code indicating type of data collected (R = Rh, L = Low Angle [15 o], H = high angle [90o], S = 
(spare, normally used for UV), C = Concentration (RI)) 

• Date/Time for file generation 

• Sample Name  

• Eluant 

• Information 

• Operator 

• Dn/Dc 

• Flow rate 

• Injection Volume  

• Conc 

• RI 

• UV Ext 

• Temp 

You can sort the files by clicking on the appropriate button (e.g. the Sample Name button will list the files 
alphabetically based on the sample name). 
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Chapter 6 

Measuring Proteins and other Monodisperse Species 
 

6.1 OVERVIEW 

A typical application of Discovery32 is the determination of the molecular weight distribution, the 
hydrodynamic radius and related parameters of proteins using data that was acquired via 
PrecisionAcquire32. In solution, a protein will typically provide one or a few peaks corresponding to the 
monomer, dimer, trimer, tetramer, etc. In contrast: when a synthetic polymer is studied, a large number of 
species is observed (with a small molecular weight difference between the various species). 

The discussion in this chapter also relates to other applications where one or a relatively few polymeric 
species are present. A similar discussion for the analysis of synthetic polymers and other polydisperse 
applications is presented in Chapter 7. 

This chapter describes: 

• Opening a file (Section 6.2) 

• Viewing the Chromatogram (Section 6.3)  

• Establishing Calculation Parameters (Section 6.4) 

• Preparing the Chromatogram (Section 6.5) 

• Calibrating the System with RI Detection (Section 6.6)  

• Checking Calibration Constants with RI Detection (Section 6.7) 

• Calibrating the System with UV Detection (Section 6.8)  

• Checking Calibration Constants with UV Detection (Section 6.9) 

• Analyzing Analytical Data on a Routine Basis (Section 6.10) 

Note: The calibration data, calibration guidelines and sample data presented in this chapter refer to the use 
of a 2.00 mg/mL solution of BSA (Bovine Serum Albumin). A detailed discussion of the analytical 
conditions used to collect the data is presented in Appendix A. It is not unlikely that data that you collect 
may be slightly different from that presented in this chapter, (e.g. retention times will differ if a different 
column is used). 
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6.2 OPENING A FILE 

When Discovery32 is opened, the Main window is presented as shown in Figure 6-1. The Preview File 
chromatogram that is presented in the upper right corner represents the file that was open when the 
application was closed and the bottom half of the display describes files that are in the directory that is 
indicated in the field adjacent to the Change button. The files in the listing can be sorted by the Filename, 
Eluant, Sample Name, dn/dc or Date by selecting the appropriate radio button. 

A detailed discussion of the contents on the line describing a file is presented in Section 5.4. 

 
Figure 6-1:  The Discovery32 Lightscattering Analysis Software Window 

To access files in another directory, press the Change button, and select the desired directory in the 
Browse for Folder dialog box that is presented.  

To open a file, double click on the line that represents the desired file. As an alternative, you can open a 
file by selecting Open on the File menu and choosing the file from the Open dialog box. The selected line 
will be indicated in red, directly below the sort buttons (e.g. C:\PDI\Data\040201.$06 is loaded) and will 
be indicated in the Preview File field.  
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If desired, you can select a file from a different directory than that indicated in the field to the right of the 
Change button. If you choose a file in this manner, the indicated directory remains the same and the new 
chromatogram will be loaded, but there will be red indicated files in that list. The file that is loaded will 
be indicated in green immediately above the file list. If you do not select any files in the file list, and close 
Discovery32, then reopen the program, the directory that will be opened and listed in the field to the right 
of the “change” button will be the based on the last file accessed before closing. 

When the file is selected, the window appears as shown in Figure 6-2.  

 
Figure 6-2:  The Main Discovery Window with 040201.$06 loaded 
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6.3 VIEWING THE CHROMATOGRAM  

The chromatogram for the active file (Figure 6-3) can be viewed by selecting Chromatogram on the 

Option menu or pressing the  button on the toolbar. The status bar will indicate the name of the file 
that was loaded. 

 

Figure 6-3:  A Typical Chromatogram 

Note: The time/date for data acquisition and the information on the bottom line can be automatically 
added to the chromatogram via the Display Options dialog box (Section 5.2.1.6). The file name indicated 
on the bottom line will not match the file name that was loaded if the file was saved with a different 
name. 

If desired, you can expand the window to full frame by grabbing a corner and dragging it to the desired 
size. In addition, you can expand a region of the chromatogram by pointing the mouse at the upper left 
corner of the desired area and dragging to the desired right hand corner.  

Some users prefer using a white background to the chromatogram (to improve contrast) and the 
background of the chromatogram dialog box can be changed using the Scheme field on the Appearance 
tab on the Display Properties dialog box (accessed via the Display icon on the Control Panel). This is a 
standard Windows function. 
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6.4 ESTABLISHING CALCULATION PARAMETERS 

The Setup Calculations dialog box (Figure 6-4) is used to indicate the instrument configuration that was 
used to collect the data. In addition, this dialog box is used to coordinate the various activities that are 
performed to determine the calibration constants for the system. 

6.4.1 The Options Tab 

 
Figure 6-4:  Setup Calculations Dialog Box - Options Tab 

At this point, we will select the desired fields (which should correspond to the configuration of your 
system). In Figure 6-4, the selections are:  

• Detector Calculations - RI/Light Scattering 

• Calculation Types - Mw Calculations/15 & 90 degree, Rh Calculations, Rg, MW;                   
MW Smoothing - None 

• Laser Wavelength - 809 nm  

If your system is capable of measuring Rh, an 809 nm laser is definitely included in your system. For 
other systems, please refer to your CalCert document for the actual wavelength of the laser in your 
system. If you are uncertain (or believe that your unit has been upgraded), please contact Precision 
Detectors to verify the laser that installed in your unit.  
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6.4.2 The Detectors Tab 

The Detectors tab (Figure 6-5) is provided to indicate the detectors that you want to display on the 
chromatogram.  

 
Figure 6-5:  Setup Calculations Dialog Box - Detectors Tab 

Check the detectors that you would like to view on the chromatogram display. You can select one 
detector to be defined by the left Y-axis and another detector to be defined by the right Y-axis. If you 
select both left and right access radio buttons for the same channel, then only one axis will be displayed 
on the left axis. This makes the chromatogram window larger and easier to process. 

Note: Typically, the UV and Rh data are not presented when you are defining the baseline and integrating 
the peak(s) for the RI detector, and the RI and Rh data are not presented when you are defining the 
baseline and integrating the peak(s) for the UV detector. This is done so that so that the data from the 
light scattering detectors is more readily viewed. 
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6.4.3 The Constants Tab 

The Constants tab (Figure 6-6) is used to present a variety of instrumental constants that are required to 
calculate light scattering properties.  

 
Figure 6-6:  Setup Calculations Dialog Box - Constants Tab 

The Run RI and Run UV constants shown on the left side of the Constants tab are the current values that 
are being applied to the chromatogram and are stored with the data file, while the constants shown on the 
right side are the instrument values which are currently stored in Discovery32. You can think of these 
constants as being analogous to the memory function of a calculator. They are available to update any 
files with these constants. When a calibration routine is performed both the Run and Instrument side 
constants are updated with latest determined values. If you choose to update the constants in 
PrecisionAcquire32, they can be copied and pasted individually into the Calibration dialog box of that 
program from the Discovery32 program.  

Calibration constants can be manually entered into the appropriate fields. When the data has been entered 
to a Run field (e.g. Inter-detector Vol (ml)) it can be copied into the corresponding Instrument field using 
the  key or vice versa using the corresponding  key. If values are moved using the  key or  key, a 
dialog box will pop up asking you to confirm the change. 

The Update key becomes active after a change has been made. To accept the changes made, the update 
button must be clicked. 

If you want to apply the newly determined values to stored files, press Inst. Cal. Values key. It will then 
be necessary to recalculate the values.  
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6.4.4 Determining Calibration Constants 

The Determine Cal. Constants tab (Figure 6-7) is used to generate the calibration constants for the 
system. When you first open up the screen, all constants are blank if you have not yet established 
baselines.  

 
Figure 6-7:  Setup Calculations Dialog Box - Determine Cal Constants Tab 

This dialog box is used to review the calibration process as described in Section 6.7. 
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6.5 PREPARING THE CHROMATOGRAM FOR DATA PROCESSING  

Preparing the chromatogram refers to determining the baseline, normalizing the chromatogram and 
selecting the region to be integrated. 

6.5.1 Establishing A Baseline 

The baseline is used to indicate the “zero signal” level for the sample so that the area of the peak can be 
properly determined. The baseline is normally selected by defining two points in the chromatogram that 
are on a flat part of the trace (one before and one after the peak(s) of interest. The baseline is indicated on 
the chromatogram as a black line (e.g. see the line at 342 mV for the 90o trace in Figure 6-8).  

To establish a baseline: 

a) Open the Operate on Chromatograms tab of the Chromatograms dialog box (Figure 6-8). 

 
Figure 6-8:  The Chromatograms Dialog Box - Operate on Chromatograms Tab 

b) Right click on the chromatogram to present a pop-up selection box and select Set Baseline to present 
the Select Detectors dialog box (Figure 6-9). 

     6 



 

6-10  Discovery32 - Chapter 6 

 
Figure 6-9:  Select Detectors Dialog Box 

There are two options for selecting baselines (Least Squares Fit or Point to Point Fit). If the baseline 
is flat before and after the peak of interest, we recommend that the Point to Point Fit radio button be 
selected. If there is a flat region of baseline only on one side of the peak(s), then the least squares fit is 
appropriate as it can extrapolate baselines.  

The baseline must be established for all detector channels for the selected calculation types (e.g. 
RI/LS 90o requires the RI and 90o channels to have baselines). If 15o data is collected but is not being 
used for the calculation; then baselines for that channel is not required (the Low Angle Scatter check 
box refers to the 15o scatter channel and the High Angle Scatter check box refers to the 90 o scatter 
channel). 

c) For Point-to-Point baselines, select that feature along with the channels you are going to establish 
baselines for and click OK. The cursor will appear as a + sign (two vertical lines may be displayed on 
the plot, indicating previously determined baseline regions based on Least squares techniques or there 
may be small rectangular boxes which indicate point to point baselines). 

d) You may start and stop the baseline selection (going from left to right ) anywhere on the 
chromatogram and independent of any vertical lines that show previously determined regions. As an 
alternative, you may move the vertical lines by holding down the Ctrl button down and clicking while 
dragging the rectangular box. Select a region of the chromatogram where the baseline is flat in front 
of the peak(s) of interest and then release the mouse button. Repeat the process for the other traces if 
they require selection of different regions to obtain good baselines. In Figure 7-10, we have set the 
baseline indicators to approximately 3.0 min and 11.0 min.  
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Figure 6-10:  Setting the Baseline 

e) Once you have set both vertical lines to the desired times, click in the region between the two lines to 
save the settings (if you want to erase the settings and start over, click outside the region defined by 
the vertical lines). After you have accepted the settings, the vertical lines disappear and a small square 
represents where the baseline is set for each detector trace.  

f) When selecting baselines by Least squares, click and drag on a flat region of baseline before or after 
the peak of interest. A baseline will be extrapolated based on the region you have selected. You can 
also have the least squares method behave like point to point by selecting a baseline region as 
discussed above, then select a second region on the other side of the peak to repeat the process. 

Note: When the baseline selected in the above manner, the same points are selected for each detector 
trace. If you want to change the baseline for a specific detector, click on the square and drag it to the 
desired point. 

6.5.2 Normalizing the Heights and Zooming on the Peaks 

Selecting the integration region is simplified if the peak(s) of interest are sufficiently large so that you can 
see where the trace begins to deviate from the baseline. Typically, the operator will normalize the peaks 
so that the largest peak in the region of interest is full scale. Zooming on the peaks is used to have the 
region of interest to be full scale on the display. 

 

     6 



 

6-12  Discovery32 - Chapter 6 

To Normalize the Height of the Peaks:  

a) Right click on the chromatogram to present the pop-up menu. 

b) Select Normalize Region. The cursor will appear as a + sign. 

c) Select the region that you would like to normalize in the same way you selected the baseline points.  

To Zoom the Normalized Region: 

a) Take the cursor and place it on one of the corners of the desired area to be zoomed. 

b) Click on the left mouse button and drag to the opposite corner, then release the mouse button. In this 
example, we will start at 4.0 minutes by the lower baseline and drag the mouse to 13.0 by the upper 
boundary. This zoom will present the display shown in Figure 6-11. (Avoid any baseline 
perturbations such as large negative dips near the terminal region of the chromatogram. This is more 
prominent with RI detectors than observed for UV.)  

 
Figure 6-11:  Normalized, Zoomed Display 
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6.5.3 Defining the Integration Region 

The integration region is defined in the same manner as the selection of the baseline. 

To Define the Baseline: 

a) Right click on the chromatogram and select Set Integration Region on the pop-up menu. 

b) Move the vertical lines on the chromatogram to indicate the region to be integrated. When you have 
selected the appropriate limits, press inside the vertical lines.  

The arrows on the baseline indicate the region for which the area will be determined (e.g. between 9.2 and 
9.8 minutes on Figure 6-11). You may also move previously determined baseline arrows by holding down 
the Ctrl button and clicking the arrow to be moved. Hold the left mouse button down and drag the arrow 
to where you want to relocate it. 

6.6 DETERMINING CAL CONSTANTS 

It is necessary to determine the following calibration parameters: 

• The Inter-Detector Volume (Section 6.6.1) 

• Determining the RI Constant (Section 6.6.2) 

6.6.1 Determining the Inter-Detector Volume  

In Setup Calculation/Options select RI/Light Scattering and the calculation type. To determine the Inter-
detector volume, access the Determine Cal Constants tab of the Setup Calculation dialog box (Figure 6-
12).  
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Figure 6-12:  Setup Calculation Dialog Box - Determine Cal Constants tab  

If the standard that you are using consists of a single peak and has no aggregation: 

a) Verify that all of the information in the fields in the lower half of the tab is correct, and edit as 
appropriate. The values should be completely indicated (e.g. the molecular weight should be 66,230 
D rather than 66.23 kD). 

b) Check the Apply All box to update the fields in red.  

If the standard that you are using includes measurable dimer, trimer and higher order aggregations (as is 
the case with BSA), it will be necessary to include the total area of these peaks so that an accurate 
concentration constant can be obtained. 

Note: Check that the parameters indicated in the lower half of the dialog box are correct before 
proceeding. It is especially important that the indicated flow rate corresponds to the value delivered by the 
solvent delivery module. 

The Quality Factor should be between 0.98 and 1.00. If it is in this range, place a check in the Accept box 
corresponding to Inter-detector volume and then press Apply to implement the action. 

At this point, you should inspect the chromatogram to ensure that the peaks are properly aligned using the 
Operate on Chromatogram tab command on the Chromatograms dialog box. A typical chromatogram is 
presented in Figure 6-13. 
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Figure 6-13:  Alignment of Peaks 

The three traces should be coincident. If they are not coincident, it will be necessary to change the value 
of the Interdetector Vol field on the Constants tab (Figure 6-14) slightly. This is very rarely required. 
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Figure 6-14:  Setup Calculation - Constants Tab 

To align the peaks, change the value slightly (typically a change of 1% is used) and press Apply on the 
Constants tab, then view the chromatogram again. This procedure may require a number of iterations 
until the chromatograms coincide. 

6.6.2 Determining the RI Constant 

To determine the RI Constant 

a) Expand the integration region of the chromatogram to include the entire area of the peaks for the 
refractive index detector. The area should include the monomer and the aggregates (if any) but the 
terminal peak should be excluded. 

b) Return to the Determine Cal Constants tab of the Setup Calculation dialog box and check the Accept 
box that corresponds to the Refractive Index Constant value, then click Apply. 

Note: Precision Acquire32 will report RI constants that are between 75000 and 85000, which are not 
compatible with Discovery32, where the RI constant is typically around 2 to 3. 
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6.6.3 Determine Calibration Constants for 15o and 90o Channels 

To determine the Calibration Constants for 15o and 90o channels: 

a) Set integration parameters for the monomer peak. Approximately 10 percent by height above the lift 
off and the same on the landing. (This is to avoid possible coelutions with dimer and polypeptide 
fragments). 

b) Return to the Determine Cal Constants tab of the Setup Calculation dialog box and place a check 
mark in the Accept box adjacent to the 90o and or 15o constant entry. 

6.7 CHECKING CALIBRATION RESULTS - RI DETECTOR 

To Check Calibration Results: 

a) Access the Run Params tab of the Results dialog box (Figure 6-15). 

 
Figure 6-15:  Results Dialog Box - Run Params Tab 
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The following items should be checked on this tab.  

• The calibration of the monomer peak for BSA should be correct for RI for 15o and 90o. 

• The Calculated Value of dn/dc in the Sample Constants field. If BSA is used, the calculated 
value is 0.1355 mg/ml and the calculated value should be 0.1355 if the area of the monomer 
peak was exactly 2 mg/mL. The entered value was 0.1670. It should be noted that since BSA 
forms dimers, trimers, etc., the value of 2 is not expected. 

• The Calculated Value of RI in the Concentration Detectors field. If BSA is used, the 
calculated concentration of the monomer peak is 1.6223 mg/mL, which is correct due to the 
presence of dimers and other aggregates. 

b) Access the Summary tab of the Results dialog box (Figure 6-16). 

 
Figure 6-16:  Results Dialog Box - Summary Tab 
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The following items should be checked on this tab: 

• The molecular weight, which should be in the order of 66,230 daltons for BSA. This is the 
molecular weight for the sample corresponding to the slice of the chromatogram that was 
integrated. The calibration is based on the total area of the light scattering signal and the 
Refractive index detector signal. If the curves are not perfectly coincident, the molecular weight 
will be calculated incorrectly.  

• The value of Mw/Mn for the monomer peak should be very close to 1.000. 

Further checking can be performed by integrating the dimer, trimer and tetramer. The calculated 
molecular weight of the dimer should be approximately 1.97 times the calculated weight of the monomer, 
that of the trimer should be approximately 2.96 that of the monomer and that of the tetramer should be 
approximately 3.95 that of the monomer. 

To verify operation for the large aggregation of BSA, integrate the full RI chromatogram. The average 
MW should be 73 kD with a polydispersity of 1.062. 

6.8 CALIBRATING THE UV AND LS CHANNELS 

To calibrate the UV detector: 

a) Return to the Detectors page of the Setup Calculation dialog box (Figure 6-5). and deselect the RI 
channel. Select the UV channel by activating the check box. In addition, check the left and right Y-
Axis buttons for UV. 

b) Establish the baseline for the UV detector. 

c) Zoom in on the monomer/dimer region and reintegrate the monomer region. The UV trace may 
slightly precede the light scattering channels  

d) Return to the Determine Cal Constants tab of the Setup Calculations dialog box and accept the 
Interdetector volume (which is now negative), 

e) Return to the chromatogram and see if the UV peak and the light scattering peaks are coincident. If 
they are not, access the Constants tab of the Setup Calculations dialog box and make a small change 
in the Inter-detector Vol field of the Constants tab as we did earlier.  

f) Repeat the above process until the chromatograms are coincident, then accept the constant and press 
Apply.  

g) Reintegrate the monomer region, then accept the 15 and 90o constants and finally press Apply. 

     6 



 

6-20  Discovery32 - Chapter 6 

6.9 CHECKING CALIBRATION CONSTANTS WITH UV DETECTION  

To check calibration using UV Detection: 

a) Access the Run Params tab of the Results dialog box.  

b) Verify that the monomer BSA peak is correct (66.50 kD for UV/15 and UV/90). 

c) The entered UV extinction coefficient (Sample Constants) was 0.6750, and the calculated values 
should be 0.5453 (if the monomer concentration was 2 mg/mL). 

d) The entered value for the UV concentration was 2.0000 and the calculated value for the monomer 
peak is 1.6158 mg/mL (since some of the BSA is aggregated). 

e) The average Mw for BSA should be close to 66.23kD. While the calibration is based upon the total 
area of the light scattering signal and the UV signal, the calculations are performed on the peak on a 
slice by slice approach. The calibration is based on the total area of the light scattering signal and the 
UV detector signal. If the curves are not perfectly coincident, the molecular weight will be calculated 
incorrectly.  

f) The value of Mw/Mn for the heart-cut of the monomer peak should be very close to 1.00 

Further checking can be performed by integrating the dimer, trimer and tetramer. The calculated 
molecular weight of the dimer should be approximately 2 times the calculated weight of the monomer, 
that of the trimer should be approximately 3 times that of the monomer and that of the tetramer should be 
slightly higher than 4 times that of the monomer as there may be higher order aggregates coeluting within 
that region. 

An additional check can be made by comparing the data from the UV and the RI measurements. The UV 
should track closely with the RI data, but shows a little less response in the tetramer region, which leads 
to a higher calculation for the Mw (compared to the RI). 



 

Discovery32 - Chapter 6  6-21 

6.10 ANALYZING ANALYTICAL DATA  

Data that is collected from Precision Acquire32 can be readily processed via Discovery32 using the 
following protocol 

a) Open the file as described in Section 6.2.  

b) Indicate the baseline and integration parameters as described in Section 6.4. 

If you are analyzing data from a number of samples, it may be convenient to use the Autointegration 
tab of the Chromatograms dialog box (Figure 6-17) This feature lets you apply the integration 
parameters of a given file to other files. 

 
Figure 6-18:  Chromatograms Dialog Box - Autointegration Tab  

To use the Autointegration feature: 

i) Press the Add Files to List button to present a dialog box that is used to select the desired 
files. 

ii) When all files are selected, press the Auto-Integrate Using >>> button. The file that is used 
as a template is selected on the pop-up menu on the Chromatogram window.  

c) View the Summary tab of the Results dialog box (Figure 6-16) to view the desired data. Similar plots 
for Rg and Rh can be obtained using the corresponding tabs. 
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d) Click the Mw Dist tab to present a molecular weight distribution (Figure 6-19). 

 
Figure 6-19  Molecular Weight Distribution Plot 

e) Click the Mw vs. Elu tab to present a chromatogram which presents the Mw as the ordinate (Figure 6-
20). Similar chromatograms for Rh and Rg can be viewed via the corresponding plots.  
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Figure 6-20:  Mw Chromatogram 

To view hydrodynamic data, select Rh on the Detector tab, and select the Y-Axis Left and Y Axis Right 
boxes. The results will be seen with + signs (Figure 6-21) with the left y-axis showing the Rh scale. 
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Figure 6-21:  Hydrodynamic Data 
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Chapter 7 

Measuring Synthetic Polymers 
 

7.1 OVERVIEW 

A typical application of Discovery32 is the determination of the molecular weight distribution, the 
hydrodynamic radius and related parameters of synthetic polymers using data that was acquired via 
PrecisionAcquire32. A synthetic polymer sample may contain a single polymeric species, which would 
correspond to a single peak in the chromatogram. In many cases, a synthetic polymer sample includes a 
number of species that are fairly similar in nature, but differ in the number of the repeating polymer units. 
In this latter scenario, a chromatogram with a large number of closely spaced peaks (if the column is able 
to resolve the various species) or a broad envelope, which corresponds to the elution of the various 
species (if the column is not able to resolve the various species) would be observed. 

The discussion in this chapter also relates to other applications where one or a relatively few polymeric 
species are present. A similar discussion for the analysis of natural polymers, virons and other 
monodisperse applications is presented in Chapter 6. 

This chapter describes: 

• Opening a file (Section 7.2) 

• Viewing the Chromatogram (Section 7.3)  

• Establishing Calculation Parameters (Section 7.4) 

• Preparing the Chromatogram (Section 7.5) 

• Calibrating the System with RI Detection (Section 7.6)  

• Checking Calibration Constants with RI Detection (Section 7.7) 

• Calibrating the System with UV Detection (Section 7.8)  

• Checking Calibration Constants with UV Detection (Section 7.9) 

• Analyzing Analytical Data on a Routine Basis (Section 7.10) 

Note: The calibration data, calibration guidelines and sample data presented in this chapter refer to the use 
of a polystyrene standard with a molecular weight of 96.4 kD. A detailed discussion of the analytical 
conditions used to collect the data is presented in Appendix A. It is not unlikely that data that you collect 
may be slightly different from that presented in this chapter, (e.g. retention times will differ if a different 
column is used). 
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7.2 OPENING A FILE 

When Discovery32 is opened, the Main window is presented as shown in Figure 7-1. The Preview File 
chromatogram that is presented in the upper right corner represents the file that was open when the 
application was closed and the bottom half of the display describes files that are in the directory that is 
indicated in the field adjacent to the Change >>> button. The files in the listing can be sorted by the 
Filename, Eluant, Sample Name, dn/dc or Date by selecting the appropriate radio button. 

A detailed discussion of the contents on the line describing a file is presented in Section 5.4. 

 
Figure 7-1:  The Discovery32 Lightscattering Analysis Software Window 

To access files in another directory, press the Change button, and select the desired directory in the 
Browse for Folder dialog box that is presented.  

To open a file, double click on the line that represents the desired file. As an alternative, you can open a 
file by selecting Open on the File menu and choosing the file from the Open dialog box. The selected line 
will be indicated in red, directly below the sort buttons (e.g. C:\PDI\Data\040201.$06 is loaded in Figure 
7-1 and will be indicated in the Preview File field.  
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If desired, you can select a file from a different directory than that indicated in the field to the right of the 
Change button. If you choose a file in this manner, the indicated directory remains the same and the new 
chromatogram will be loaded, but there will be red indicated files in that list. The file that is loaded will 
be indicated in green immediately above the file list. If you do not select any files in the file list, and close 
Discovery32, then reopen the program, the directory that will be opened and listed in the field to the right 
of the Change >>> button will be the one that contains the last file that was accessed before closing. 

When the file is selected, the window appears as shown in Figure 7-2.  

 
Figure 7-2:  The Main Discovery Window with 040201.$06 loaded 
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7.3 VIEWING THE CHROMATOGRAM  

The chromatogram for the active file (Figure 7-3) can be viewed by selecting Chromatogram on the 

Option menu or pressing the  button on the toolbar. The status bar will indicate the name of the file 
that was loaded. 

 

Figure 7-3:  A Typical Chromatogram 

Note: The time/date for data acquisition and the information on the bottom line can be automatically 
added to the chromatogram via the Display Options dialog box (Section 5.2.1.6). The file name indicated 
on the bottom line will not match the file name that was loaded if the file was saved with a different 
name. 

If desired, you can expand the window to full frame by grabbing a corner and dragging it to the desired 
size. In addition, you can expand a region of the chromatogram by pointing the mouse at the upper left 
corner of the desired area and dragging to the desired right hand corner.  

Some users prefer using a white background to the chromatogram (to improve contrast) and the 
background of the chromatogram dialog box can be changed using the Scheme field on the Appearance 
tab on the Display Properties dialog box (accessed via the Display icon on the Control Panel). This is a 
standard Windows function. 
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7.4 ESTABLISHING CALCULATION PARAMETERS 

The Setup Calculations dialog box (Figure 7-4) is used to indicate the instrument configuration that was 
used to collect the data. In addition, this dialog box is used to coordinate the various activities that are 
performed to determine the calibration constants for the system. 

7.4.1 The Options Tab 

 
Figure 7-4:  Setup Calculations Dialog Box - Options Tab 

At this point, we will select the desired fields (which should correspond to the configuration of your 
system). In Figure 7-4, the selections are:  

• Detector Calculations - RI/Light Scattering 

• Calculation Types - Mw Calculations/15 & 90 degree, Rh Calculations, Rg, MW;                   
MW Smoothing - None 

• Laser Wavelength - 809 nm  

If your system is capable of measuring Rh, an 809 nm laser is definitely included in your system. For 
other systems, please refer to your CalCert document for the actual wavelength of the laser in your 
system. If you are uncertain (or believe that your unit has been upgraded), please contact Precision 
Detectors to verify the laser that installed in your unit.  
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7.4.2 The Detectors Tab 

The Detectors tab (Figure 7-5) is provided to indicate the detector traces that you want to display on the 
chromatogram.  

 
Figure 7-5:  Setup Calculations Dialog Box - Detectors Tab 

Check the detector traces that you would like to view on the chromatogram display. You can select one 
detector to be defined by the left Y-axis and another detector to be defined by the right Y-axis. If you 
select both left and right access radio buttons for the same channel, then only one axis will be displayed 
on the left axis. This makes the chromatogram window larger and easier to process. 

Note: Typically, the UV and Rh data are not presented when you are defining the baseline and integrating 
the peak(s) for the RI detector, and the RI and Rh data are not presented when you are defining the 
baseline and integrating the peak(s) for the UV detector. This is done so that so that the data from the 
light scattering detectors is more readily viewed. 
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7.4.3 The Constants Tab 

The Constants tab (Figure 7-6) is used to present a variety of instrumental constants that are required to 
calculate light scattering properties.  

 
Figure 7-6:  Setup Calculations Dialog Box - Constants Tab 

The Run RI and Run UV constants shown on the left side of the Constants tab are the current values that 
are being applied to the chromatogram and are stored with the data file, while the constants shown on the 
right side are the instrument values which are currently stored in Discovery32. You can think of these 
constants as being analogous to the memory function of a calculator. They are available to update any 
files with these constants. When a calibration routine is performed, both the Run and Instrument side 
constants are updated with latest determined values. If you choose to update the constants in 
PrecisionAcquire32, they can be copied  automatically by selecting Update Acquire32 Constants from 
the drop down menu “options” found in the main browsing window of Discovery32. 

Calibration constants can be manually entered into the appropriate fields. When the data has been entered 
to a Run field (e.g. Inter-detector Vol (ml)) it can be copied into the corresponding Instrument field using 
the  key or vice versa using the corresponding  key.  

The Update key becomes active after a change has been made, to accept the changes made, the update 
button must be clicked. 

If you want to apply the newly determined values to stored files, press Inst. Cal. Values key. It will then 
be necessary to recalculate the values. If values are moved using the  key or  key a dialog box will 
pop up to confirm the change 
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7.4.4 Determining Calibration Constants 

The Determine Cal. Constants tab (Figure 7-7) is used to generate the calibration constants for the 
system. When you first open up the screen, all constants are blank if you have not yet established 
baselines.  

 
Figure 7-7:  Setup Calculations Dialog Box - Determine Cal Constants Tab 

This dialog box is used to review the calibration process as described in Section 7.7. 
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7.5 PREPARING THE CHROMATOGRAM FOR DATA PROCESSING  

Preparing the chromatogram refers to determining the baseline, normalizing the chromatogram and 
selecting the region to be integrated. 

7.5.1 Establishing A Baseline 

The baseline is used to indicate the “zero signal” level for the sample so that the area of the peak can be 
properly determined. The baseline is normally selected by defining two points in the chromatogram that 
are on a flat part of the trace (one before and one after the peak(s) of interest. The baseline is indicated on 
the chromatogram as a black line (e.g. see the line at approximately 275 mV for the 15o trace in Figure 7-
8).  

To establish a baseline: 

a) Open the Operate on Chromatograms tab of the Chromatograms dialog box (Figure 7-8). 

 
Figure 7-8:  The Chromatograms Dialog Box - Operate on Chromatograms Tab 

b) Right click on the chromatogram to present a pop-up selection box and select Set Baseline to present 
the Select Detectors dialog box (Figure 7-9). 
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Figure 7-9:  Select Detectors Dialog Box 

There are two options for selecting baselines (Least Squares Fit or Point to Point Fit). If the baseline 
is flat before and after the peaks of interest, we recommend that the Point to Point Fit radio button be 
selected. If there is a flat region of baseline only on one side of the peak(s), then the least squares fit is 
appropriate as it can extrapolate baselines. 

The baseline must be established for all detector channels for which data has been collected for the 
selected calculation types .e.g. RI/LS 90o requires the RI and 90o channels to have baselines, if 15o 
deg is collected but is not being used for the calculation, then baselines for that channel is not 
required.(the Low Angle Scatter check box refers to the 15o scatter channel and the High Angle 
Scatter check box refers to the 90 o scatter channel). 

c) For Point-to-Point baselines, select that feature along with the channels you are going to establish 
baselines for and click OK. The cursor will appear as a + sign (two vertical lines may be displayed on 
the plot, indicating previously determined baseline regions based on Least squares techniques or there 
may be small rectangular boxes which indicate point to point baselines). 

d) You may start and stop the baseline selection (going from left to right) anywhere on the 
chromatogram and independent of any vertical lines that show previously determined regions. As an 
alternative, you may move the vertical lines by holding down the Ctrl button down and clicking while 
dragging the rectangular box. Select a region of the chromatogram where the baseline is flat in front 
of the peak(s) of interest and then release the mouse button. Repeat the process for the other traces if 
they require selection of different regions to obtain good baselines. In Figure 7-10, we have set the 
baseline indicators to approximately 4.2 min and 5.1 min.  
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Figure 7-10:  Setting the Baseline 

e) Once you have set both vertical lines to the desired times, click in the region between the two lines to 
save the settings (if you want to erase the settings and start over, click outside the region defined by 
the vertical lines). After you have accepted the settings, the vertical lines disappear and a small square 
represents where the baseline is set for each detector trace.  

f) When selecting baselines by Least squares, click and drag on a flat region of baseline before or after 
the peak of interest. A baseline will be extrapolated based on the region you have selected. You can 
also have the least squares method behave like point to point by selecting a baseline region as 
discussed above, then select a second region on the other side of the peak to repeat the process. 

Note: When the baseline selected in the above manner, the same points are selected for each detector 
trace. If you want to change the baseline for a specific detector, click on the square and drag it to the 
desired point. 

7.5.2 Normalizing the Heights and Zooming on the Peaks 

Selecting the integration region is simplified if the peak(s) of interest are sufficiently large so that you can 
see where the trace begins to deviate from the baseline. Typically, the operator will normalize the peaks 
so that the largest peak in the region of interest is full scale. Zooming on the peaks is used to have the 
region of interest to be full scale on the display. 
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To Normalize the Height of the Peaks:  

a) Right click on the chromatogram to present the pop-up menu. 

b) Select Normalize Region. The cursor will appear as a + sign. 

c) Select the region that you would like to normalize in the same way you selected the baseline points.  

To Zoom the Normalized Region: 

a) Take the cursor and place it on one of the corners of the desired area to be zoomed. 

b) Click on the left mouse button and drag to the opposite corner, then release the mouse button. In this 
example, we will start at 4.0 minutes by the lower baseline and drag the mouse to 7.2 by the upper 
boundary. This zoom will present the display shown in Figure 7-11. (Avoid any baseline 
perturbations such as large negative dips near the terminal region of the chromatogram. This is more 
prominent with RI detectors than observed for UV.) 

 
Figure 7-11:  Normalized, Zoomed Display 
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7.5.3 Defining the Integration Region 

The integration region is defined in the same manner as the selection of the baseline. 

To Define the Baseline: 

a) Right click on the chromatogram and select Set Integration Region on the pop-up menu. 

b) Move the vertical lines on the chromatogram to indicate the region to be integrated. When you have 
selected the appropriate limits, press inside the vertical lines.  

The arrows on the baseline indicate the region for which the area will be determined (e.g. between 9.2 and 
9.8 minutes on Figure 7-11). You may also move previously determined baseline arrows by holding down 
the Ctrl button and clicking the arrow to be moved. Hold the left mouse button down and drag the arrow 
to where you want to relocate it. 

7.6 DETERMINING CAL CONSTANTS 

It is necessary to determine the following calibration parameters: 

• The Inter-Detector Volume (Section 7.7.1) 

• Determining the RI Constant (Section 7.7.2) 

7.6.1 Determining the Inter-Detector Volume  

In Setup Calculation/Options select RI/Light Scattering and the calculation type. To determine the Inter-
detector volume, access the Determine Cal Constants tab of the Setup Calculation dialog box (Figure 7-
11).  
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Figure 7-12:  Setup Calculation Dialog Box - Determine Cal Constants Tab  

If the standard that you are using consists of a single peak and has no aggregation: 

a) Verify that all of the information in the fields in the lower half of the tab is correct, and edit as 
appropriate. The values should be completely indicated (e.g. the molecular weight should be 96,400 
D rather than 96.4 kD). 

b) Check the Apply All box to update the fields in red. 

Note: Check that the parameters indicated in the lower half of the dialog box are correct before 
proceeding. It is especially important that the indicated flow rate corresponds to the value delivered by the 
solvent delivery module. 

The Quality Factor should be between 0.98 and 1.00. If it is in this range, place a check in the Accept box 
corresponding to Inter-detector volume and then press Apply to implement the action. 

At this point, you should inspect the chromatogram to ensure that the peaks are properly aligned using the 
Operate on Chromatogram tab command on the Chromatograms dialog box. A typical chromatogram is 
presented in Figure 7-13. 
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Figure 7-13:  Alignment of Peaks 

The three traces should be coincident. If they are not coincident, it will be necessary to change the value 
of the Interdetector Vol field on the Constants tab (Figure 7-14) slightly. This procedure is very 
infrequently required. 
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Figure 7-14:  Setup Calculation - Constants Tab 

To align the peaks, change the value slightly (typically a change of 1% is used) and press Apply on the 
Constants tab, then view the chromatogram again. This procedure may require a number of iterations 
until the chromatograms coincide. 

7.6.2 Determining the RI Constant 

To determine the RI Constant 

a) Expand the integration region of the chromatogram to include the entire area of the peaks for the 
refractive index detector. The area should include the monomer and the aggregates (if any) but the 
terminal peak should be excluded. 

b) Return to the Determine Cal Constants tab of the Setup Calculation dialog box and check the Accept 
box that corresponds to the Refractive Index Constant value, then click Apply. 

Note: Precision Acquire32 will report RI constants that are between 75000 and 85000, which are not 
compatible with Discovery32, where the RI constant is typically around 2 to 3. 
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7.6.3 Determine Calibration Constants for 15o and 90o Channels 

To determine the Calibration Constants for 15o and 90o channels: 

a) Set integration parameters for the peak (if an envelope is observed, set parameters for the entire 
envelope). We suggest that the parameters be set approximately 10 percent by height above the lift off 
and the same on the landing. 

b) Return to the Determine Cal Constants tab of the Setup Calculation dialog box and place a check 
mark in the Accept box adjacent to the 90o and or 15o constant entry. 

7.7 CHECKING CALIBRATION RESULTS - RI DETECTOR 

To Check Calibration Results: 

a) Access the Run Params tab of the Results dialog box (Figure 7-15). 

 
Figure 7-15:  Results Dialog Box - Run Params Tab 

     7 



 

7-18  Discovery32 - Chapter 7 

The following items should be checked on this tab.  

• The calibration of the peak should be correct for RI for 15o and 90o. 

• The Calculated Value of dn/dc in the Sample Constants field. 

• The Calculated Value of RI in the Concentration Detectors field. 

b) Access the Summary tab of the Results dialog box (Figure 7-16). 

 
Figure 7-16:  Results Dialog Box - Summary Tab 

The following items should be checked on this tab: 

• The molecular weight, which should be in the order of 96,400 Daltons for the Polystyrene 
sample. This is the molecular weight for the sample corresponding to the slice of the 
chromatogram that was integrated. The calibration is based on the total area of the light scattering 
signal and the Refractive index detector signal. If the curves are not perfectly coincident, the 
molecular weight will be calculated incorrectly.  

• The value of Mw/Mn for the peak should be very close to 1.000. 
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7.8 CALIBRATING THE LS CHANNELS  

To calibrate the light scattering channels 

a) Return to the Detectors page of the Setup Calculation dialog box (Figure 7-5) and deselect the RI 
channel. Select the each LS channel by activating the check box. In addition, check the left and right 
Y-Axis buttons for UV if employed). 

b) Establish the baseline for the UV detector. 

c) Zoom in on the peak and reintegrate. The UV trace may slightly precede the light scattering channels  

d) Return to the Determine Cal Constants tab of the Setup Calculations dialog box and accept the 
Interdetector volume (which is now negative), 

e) Return to the chromatogram and see if the UV peak and the light scattering peaks are coincident. If 
they are not, access the Constants tab of the Setup Calculations dialog box and make a small change 
in the Inter-detector Vol field of the Constants tab as we did earlier.  

f) Repeat the above process until the chromatograms are coincident, then accept the constant and press 
Apply.  

g) Reintegrate the monomer region, then accept the 15 and 90o constants and finally press Apply. 

7.9 ANALYZING ANALYTICAL DATA  

Data that is collected from PrecisionAcquire32 can be readily processed via Discovery32 using the 
following protocol 

a) Open the file as described in Section 7.2.  

b) Indicate the baseline and integration parameters as described in Section 7.4. 

If you are analyzing data from a number of samples, it may be convenient to use the Autointegration 
tab of the Chromatograms dialog box (Figure 7-17) This feature lets you apply the integration 
parameters of a given file to other files. 
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Figure 7-18:  Chromatograms Dialog Box - Autointegration Tab  

To use the Autointegration feature: 

i) Press the Add Files to List button to present a dialog box that is used to select the desired 
files. 

ii) When all files are selected, press the Auto-Integrate Using >>> button. The file that is used 
as a template is selected on the pop-up menu on the Chromatogram window.  

c) View the Summary tab of the Results dialog box (Figure 7-16) to view the desired data. Similar plots 
for Rg and Rh can be obtained using the corresponding tabs. 

d) Click the Mw Dist tab to present a molecular weight distribution (Figure 7-19). 
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Figure 7-19:  Molecular Weight Distribution Plot 

e) Click the Mw vs. Elu tab to present a chromatogram that presents the Mw as the ordinate (Figure 7-
20). Similar chromatograms for Rh and Rg can be viewed via the corresponding plots.  
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Figure 7-20:  Mw Chromatogram 

To view hydrodynamic data, select Rh on the Detector tab, and select the Y-Axis Left and Y Axis Right 
boxes. The results will be seen with + signs (Figure 7-21) with the left y-axis showing the Rh scale. 
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Figure 7-21:  Hydrodynamic Data  
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Chapter 8 

Theory of Light Scattering 
 

8.1 OVERVIEW 

Light Scattering refers to the process in which light from an incident polarized laser beam is scattered in 
all directions when it interacts with a molecule or particle. Light scattering is an everyday occurrence and 
was first described by Lord Rayleigh in the late 1800’s. An example of light scattering is the scattering of 
sunlight by particles in the atmosphere: the sky is blue because shorter visible wavelength radiation (blue 
light) is scattered more strongly by the gas molecules in air than light of longer wavelengths (red light). 

There are two general techniques for the measurement of physical properties of polymers (synthetic 
polymers and natural polymers such as proteins and polysaccharides), virons, liposomes and particles. 

• Static Light Scattering (also known as Rayleigh scattering or classical light scattering) - The 
intensity of the scattered light from the sample dissolved in the solvent. This difference between 
the two measurements can be used to determine the average molecular weight and Rg (radius of 
gyration). To complete the molecular weight determination, the concentration of the compound of 
interest is required (typically obtained from a refractive index detector or an absorbance detector). 
Static Light Scattering is described in Section 8.3. 

• Dynamic Light Scattering (also known as Quasi-elastic scattering, Photocorrelation 
Spectroscopy, or Beat Spectroscopy) - The fluctuations of the intensity of the scattered light is 
used to determine the diffusion coefficient of the molecules as they move in solution (Brownian 
motion). The Stokes-Einstein equation is used to determine Rh (the hydrodynamic radius of the 
molecule). Dynamic Light Scattering is described in Section 8.4. 

Static and Dynamic measurements can be made on a sample in a cuvette or in a flowing stream such as 
that found in high performance liquid chromatography (HPLC), size exclusion chromatography (SEC) or 
gel permeation chromatography (GPC). In flowing streams, measurements are made on each elution slice 
using a unique light scattering design and very fast digital signal processors (which are essentially special 
purpose computers).  

This chapter describes the fundamentals of the theory of light scattering. A short list of references for 
additional reading is presented in Section 8.5. 
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8.2 THE PHYSICAL BASIS OF LIGHT SCATTERING  

Light consists of perpendicular electric and magnetic fields that oscillate in a direction that is 
perpendicular to the direction of propagation of the light as shown in Figure 8-1. When light strikes a 
molecule, the electrons will experience a force due to the electric field and will move slightly. This 
movement will induce an oscillating dipole moment that will radiate light in all directions at the 
oscillating frequency. This radiated light is the scattered light that is detected and processed as described 
below. 

 
Figure 8-1:  Light Scattered by a Molecule 

Figure 8-1 describes the spatial arrangement of the incident light and scattered light in the light scattering 
experiment. The light is polarized in the vertical direction, thus the electric field will oscillate in the Z-
direction and the magnetic field will oscillate in the X direction.  

A diode laser, which is a monochromatic source of light that can be focused to a very small point in the 
center of the sample cell is used in PDI light scattering systems. Typical sources include a semiconductor 
laser that can provide 20 to 30 mW at 685 nm and another which provides 100 to 150 mW at 800 nm. The 
scattered light is collected at a given angle and orientation (e.g. 15o or 90o) from the incident radiation, 
and is used to deduce the desired molecular properties.  

8.3 STATIC LIGHT SCATTERING 

8.3.1 Measuring the Molecular Weight  

Note: Since Precision Detector systems include polarized laser light sources, the equations presented in 
this chapter will be slightly different than those presented in discussions of light scattering when non-
polarized sources are used.  

The electric dipole moment that is induced is shown in equation 8-1. 

           
p = α E          8-1

  
 

where: p is the dipole moment 
 α is the polarizability  
 E is the electric field 
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The polarizability can be related to measurable parameters via equation 8-2. 

Α = Mw (dn/dc)/2πNA        8-2 

where: Mw is the molecular weight 
  NA  is Avogadro’s number (6.02 x 1023 molecules per mole) 

dn/dc is the change in the index of refraction as a function of the change in 
 concentration. It is considered to be a constant for any specified solvent-solute pair under 
 constant operating conditions. 

The oscillating dipole will radiate light in all directions at the oscillating frequency. This is the origin of 
scattered light. If a single molecule has dimensions that are small with respect to the wavelength of the 
incident light , the intensity of the light can be defined by equation 8-3.  

Is = [4 π2 Mw sin2Φ (dn/dc)2 Io]/NA
2 λo

4 R2
     8-3 

where: Is is the intensity of the radiated light 
Io is the intensity of the incident light 
λo is the wavelength of light in a vacuum 
Φ and R are as defined in Figure 8-1 

If we collect light from a volume V of a solution with a concentration c (gm/mL), the intensity of 
scattered light can be found by multiplying equation 8-3 by the number of molecules in the volume V. 
The number of molecules can be expressed by NA c V/Mw. 

Now if we solve for Mw, we obtain equation 8-4 

Mw = NA
2 λo

4 R2 Is / 4 π2 Mw sin2 Φ c (dn/dc)2 Io V    8-4 

Collecting all the constants and instrumental parameters into an overall instrumental constant, A, we 
obtain equation 8-5. 

Mw = Is / A c (dn/dc)2 Io        8-5 

Equation 8-5 can be used to measure the molecular weight Mw of small molecules at any scattering angle 
θ. It should be noted, however, that larger molecules scatter less light at high values of θ than at low 
angles because of interference effects caused by the fact that light scattered from one part of the molecule 
travels a different distance from another part of the molecule, and is not in phase with light scattered . 
This phenomenon can be quantified by defining the light scattering form factor (equation 8-6). A more 
detailed discussion of the form factor is presented in Section 8.3.3. 

P(θ) = scattered intensity at angle θ / scattered intensity at angle Φ   8-6 

It should be noted that P(θ) can be written as a series as shown in equation 8-7. 

P(θ) = 1 - 1/3( q 2 Rg
2) +          8-7 

where: q = 4 π n sin (θ/2)/λo 
R is the radius of gyration of the molecule 
n is the index of refraction of the liquid 
λo is the wavelength of light in a vacuum 
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For scattering at 15o and 90o, equation 8-7 can be expressed as equations 8-8 and 8-9, respectively. 

P(θ) = 1- 26.3 (Rg n/ λo)2       8-8 

P(θ) = 1- 0.0897 (Rg n/ λo)2        8-9 

We present a table of P values for 15o and 90o degrees as a function of molecular weight (for molecules 
with molecular weight from 104  to 108 Daltons) in Table 8-1. These values assume that the molecules are 
random coils 

Table 8-1:  Value of P(90o) and P(15o) for λo = 685 nm, n = 1.5 

Mw Rg (Approx) nm P(90o) P(15o) 
5 x 103 2.3 0.9993 1.0000 
5 x 104 7 0.9993 0.9998 
5 x 105 23 0.9993 0.9976 
5 x 106 70 *1 0.9780 
5 x 107 230 *1 0.7622 

*1 values depend on shape 

If the value of P(θ) found in equation 8-7 is below 0.7, higher order components become important. In 
this case, P(θ) depends on Rg and also on the shaper of the molecule as shown in Figure 8-2. 

 
Figure 8-2:  Values of p-1(θ) as a function of q2<Rg2> for various particle shapes: 1 = Sphere,  
   2 = Gaussian Coils, 3 = Rods. 

It is clear that all three molecular shapes yield the same value of P(θ) when q2 <Rg2>is less than 
approximately 1. As the value of P(θ) increases, the shape of the molecule clearly influences the light 
scattering intensity.  
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8.3.2 Using Refractive Index Measurements to Measure Concentration 

Refractive index measurements can be used in conjunction with static light scattering measurements to 
determine the concentration of the compound in the chromatographic slice.  

The difference in refractive index between the solution under study and the pure solvent is measured by 
passing a light beam thru two cells as shown in Figure 7-3. One of the cells contains pure solvent and the 
other contains the eluant as it passes thru the cell after the column. The cell with the pure solvent should 
be filled with the solvent prior to the separation and should be at the same temperature as the eluant. 

The observed signal (RI), which corresponds to the deviation of the light beam is proportional to the 
difference in the refractive index of the fluid in the two cells as shown in equation 8-10  

RI = B (dn/dc) c        8-10 

where: B is an instrumental constant  
c is the concentration of the sample in the solvent 
dn/dc is the change in the index of refraction of the solution as a  function of 

concentration. It is considered as a constant for any  specified solvent-solute pair under 
constant operating conditions 

8.3.3 The Form Factor 

The form factor at a particular angle is the ratio of the signal at that angle when compared to the signal 
expected at the theoretical angle of 0o (where there is not form factor) as indicated by equation 8-6. The 
importance of the form factor is that small molecules (e.g. those which have a radius that is < 10 nm, 
which is small when compared to the wavelength of the incident light) are studied, generate comparable 
signals at all angles, while large molecules generate signals that are smaller at higher angles and larger at 
small angles 

8.3.4 Characteristics of Low-Angle (15o) Light Scattering  

Low Angle light scattering data is collected at a 15 angle to the incident beam and is typically used for 
determination of the molecular weights of large molecules. This measurement angle is especially useful 
for the study of proteins with molecular weight of greater than 1,000,000 Daltons and for random coils 
with molecular weight between 200,000 Daltons and about 10,000,000 Daltons. 

In addition, 15o data is also used with 90o data to measure Rg, the radius of gyration of molecules over a 
limited range of sizes (12-150 nm) using static light scattering analysis.  

8.3.5 High Angle Light Scattering  

Low angle light scattering data is collected at a 90  angle to the incident beam and is typically used with 
static light scattering analysis to measure the molecular weight of smaller molecules such as proteins with 
a molecular weight below 1,000,000 Daltons, random coils with molecular weight below 200,000 Daltons 
and for lower molecular weight non-spherical coil polymers. In addition, it is used with dynamic light 
scattering analysis to measure Rh, the hydrodynamic radius of molecules and particles from 1 to 1,000 
nm. 
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8.4 MEASURING RH VIA DYNAMIC LIGHT SCATTERING 

8.4.1 Basics of Dynamic Light Scattering 

The fundamental measurement for dynamic light scattering is the fluctuation of the intensity of the 
scattered light. This data is analyzed as described to yield the diffusion of the molecules or particles 
moving under Brownian movement.  

When polarized laser light is scattered, the scattered light is at the same wavelength as the incident beam. 
However, it should be noted that when the light is monitored over extremely short time increments (in the 
microsecond time regime), a Doppler shift occurs and the frequency of the light appears to be changing. 
As the particle moves toward the detector, the frequency increases, and as it moves away the frequency 
decreases. The amount of the increase (decrease) of the change in the frequency is related to the diffusion 
rate of the scattering molecule in the solvent.  

While the diffusion coefficient could be obtained from the frequency spectrum, it is easier to measure the 
small intensity fluctuations and then compute the autocorrelation function. The autocorrelation function is 
related to the frequency spectrum by the Fourier transform (i.e. the data processing is performed in the 
time domain rather than the frequency domain. 

From an experimental perspective, the intensity of the scattered light is detected by counting the photons 
scattered via an avalanche photodiode, an electronic device that emits a pulse every time a photon passes 
thru its detector. This high sensitivity detector sees a time varying signal rather than a relatively constant 
(in batch mode) or slowly varying “total intensity “ signal. It should be noted that even when 
measurements are taken in flow mode (SEC or GPC), the sample can be considered as slowly varying. 
This is due to the time frame of the scattered light measurement, relative to the rate of elution of the light 
scattering molecules from the column.  

The photon counting measurement is performed over a very short period of time to record the very rapid 
diffusion that is taking place. Small particles or biomolecules diffuse quickly with the scattered light 
showing rapid small fluctuations while larger particles such as protein aggregates, nanoparticles, 
polymers, etc., diffuse more slowly, resulting in lower frequency fluctuations.  

8.4.2 The Autocorrelator 

The autocorrelation function of these short interval counts is computed by an autocorrelator, which is a 
special purpose proprietary parallel computer that has been specially designed by Precision Detectors. 
The correlator uses 256 channels that can be distributed over a maximum “channel space” of 1,024 
channels. Each channel can be considered as a separate “bucket” in which the emitted photons are 
counted during the sample period (which is in the order of a few µsec. The 1,024 channel spaces occupy a 
total “time-space” of 1,024 equal sampling times that can be set by the operator according to the size and 
shape of the molecule of interest. Counts are collected in up to 256 of these channel spaces which are 
arranged logarithmically throughout the total channel space by the software, the higher density being at 
the start.  

The autocorrelator function over the 1,024 channel space is computed by correlating the counts in each of 
the channels. The results are presented on the monitor (Figure 8-3) and the value of Rh is automatically 
calculated. Observation of the correlation function provides information that is useful to optimize the 
analysis. In addition, the display indicates the fraction of the sample with the indicated particle size. 
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Figure 8-3:  Correlation Function (Left) and Particle Size Distribution (Right) for Polystyrene using 

Precision Deconvolve. Sample = Polystyrene, Radius = 45nm  

If only one particle species is present, the decay time of the autocorrelation curve provides Rh. When a 
distribution of particles is present, the correlation curve is a sum of the exponentials and the 
deconvolution algorithm in PrecisionDeconvolve is used to separate the exponentials.  

8.4.3 Using Rh to Determine the Diffusion Constant 

D, the diffusion constant of the compound of interest can be determined using the Stokes-Einstein 
equation (equation 8-11). 

Rh = k T /6π v D        8-11 

where: k is Boltzman’s constant 
  T is the temperature of the eluant 
  D is the Diffusion coefficient calculated from the autocorrelation function. 
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Chapter 9 

Printing and Exporting Data 
 

9.1 PRINTING DATA 

Discovery32 includes a routine to establish a report layout for printing chromatographic data. The report 
can include the chromatogram, the molecular weight distribution, sample information, data acquisition 
information and user generated text. A detailed discussion on the generation of a report layout is 
presented in Section 9.3.  

A typical report is shown in Figure 9-1. 

 
Figure 9-1:  A Typical Report 
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Report layouts can be stored and retrieved. The current report layout is indicated on the main window 
directly below the name of the loaded file. To select the desired layout, click Set Default Report 
Layout… on the File menu and select the desired format from the Open dialog box. 

9.2 EXPORTING DATA 

The Export Data dialog box (Figure 9-2), which is accessed via the Export command on the File menu 
used to select the desired export format.  

 
Figure 9-2:  The Export Data Dialog Box 

To export data: 

a) Select the desired format for the data by checking the format type check box(es). 

b) Select the radio button that corresponds to the data type to be exported. 

c) Select the directory for each data file type. 

d) Click the Select files for export button to access an Open dialog box and select the file to be 
exported. 

If the PLGPC or Viscotec format is selected, the file will be converted into a format that is directly 
compatible with the appropriate GPC software.  
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If ASCII format is selected, the chromatogram header and data will be converted into a format that can be 
opened by a broad range of data processing programs. In some cases (e.g. Microsoft Excel), the format of 
the input data must be specified via a wizard. When the data is used with Excel, the default options 
presented by the wizard should be chosen. 

A portion of a typical ASCII file is presented in Figure 9-3.  
[# Sample Information #]  
Filename: C:\PDI\Data\1840.$00  
Operator: > TH  
Date: > 02/18/1997  
Time: > 05:33:59  
Eluant: > TCB  
Polymer: > ADE 1840  
dndc: > 0.23  
Temperature: > 140.0  
Info1: >   
Info2: >   
[# Run Information #]  
Run Length (min): > 40  
Measurement Interval (sec): > 2.000000  
Delay Time Before Storing Readings: > 0  
Low Angle MW Cal. Constant: > 202039.296875  
High Angle MW Cal. Constant: > 43656.398438  
Flow Rate (ml/min)         : > 1.000000  
Samp. Mass Inject. Vol.(ul): > 200.000000  
Sample Concentration (mg/ml): > 2.000000  
[# Raw Data #]  
0.032   -103.276     38.389      3.503    -77.275      0.000  
0.065   -103.276     38.389      3.503    -77.275      0.000 

Figure 9-3:  Typical ASCII Output Format 

The information in the raw data columns is dependent on the type of file that is opened and the data that 
was collected.  

The file extension for the exported files are indicated in Table 9-1 (nn is replace by the run number). 

Table 9-1:  File Format Extensions 

Type  Information  Extension 
ASCII Chromatogram Ann 
 MW Bnn 
 MW-Elution Plot  Cnn 
 Rg Dnn 
 Summary Nnn 
PLGPC (Single Channel File) RI Enn 
 15o Fnn 
 90o Gnn 
 UV Hnn 
PLGPC (Dual Channel File) RI/15o Inn 
 RI/90o Jnn 
 UV/15o Knn 
 UV/90o Lnn 
Viscotek  Vdt  
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9.3 GENERATING A REPORT LAYOUT  

9.3.1 The Report Layout Dialog Box  

The ReportLayout dialog box (Figure 9-3) is used to design the template for the generation of a printed 
report. The dialog box is accessed by selecting Create Default Layout on the File menu. 

 
Figure 9-3:  The ReportLayout Dialog Box  

The user can customize the report to meet the needs of the facility or for publication. A broad variety of 
data can be placed in the report and the various objects such as the block that contains analytical report, as 
examples, you can annotate the report, indicate the integration and baseline setting regions, etc. 

The general approach of this section will be to describe each of the activities that can be performed to 
generate a part of a report. The operator can generate the desired format and layout to meet his/her 
specific needs. 

A typical report layout window is shown in Figure 9-4. 
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Figure 9-4:  Typical Report Layout 

9.3.2 The Chromatogram 

To indicate the position and size of the chromatogram on the pane: 

a) Press the  icon on the menu bar, then move the cursor to the approximate position in the pane 
and click. A rectangle outlined in red will be placed at the indicated position. 

b) Move and/or enlarge the rectangle to the desired size and position in the pane. These activities are 
done in the same manner as when you move or change the size of a window (i.e. to expand the 
rectangle, you can click on a corner and drag it). 
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9.3.3 Inserting Text 

To enter text into a page: 

a) Press the  icon and move the cursor to the desired position for the text. A rectangle will be 
placed on the pane with the message Right Click Mouse to Enter Text. 

b) Move the mouse so that the cursor is inside of the text box and right click. A Text Input dialog box 
will be presented; enter the desired text and press OK when the desired message has been entered.  

c) If desired, you can move the text box by clicking on it. 

9.3.4 Inserting a MW Distribution Plot 

To insert a molecular weight distribution plot: 

a) Press the  icon and move the cursor to the desired position for the molecular weight distribution 
plot and click. A rectangle with the title MW Dist will be presented. 

b) Move and/or enlarge the rectangle to the desired size and position in the pane. These activities are 
done in the same manner as when you move or change the size of a window (i.e. to expand the 
rectangle, you can click on a corner and drag it). 

c) Click inside the rectangle to access the Graph dialog box (Figure 9-5), and select the graph to be 
displayed. 

 

Figure 9-5:  The Graph Dialog Box 
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9.3.5 Adding Sample Information 

To add sample information: 

a) Press the  icon in the tool bar and click the cursor on the desired position in the pane to present 
the Select Sample Information dialog box (Figure 9-6). 

 
Figure 9-6:  The Select Sample Information Dialog Box 

b) Place a check mark in the items that you want included on the pane and select OK. A series of entries 
will be placed on the pane as shown in Figure 9-7. Each line of the instrumental conditions 
information and sample information can be individually moved as desired. The RI /Light Scattering 
Cal. Mode Summary as well as the Rg and Rh results can be moved as a block in the same manner as 
described above.  
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Figure 9-7:  Information Fields 

If desired, you can the move or resize the entire block using the  
keys. These keys are active only when the information fields are first opened, once you have moved any 
field, they will be deactivated. 
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9.3.6 Adding Total Area Calculation 

To add total area calculation: 

a) Click the  icon and click the cursor on the desired position in the pane to present the Mw total 
area calculation dialog box (Figure 9-8). 

 
Figure 9-8:  The Mw Total Area Calculation Dialog Box 

b) Place a check mark in the items that you want included on the pane and select OK. A series of entries 
will be placed on the pane as shown in Figure 9-9. 
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Figure 9-9:  Information Fields 
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9.3.7 Placing a Line in the Pane 

If desired, you can place a line on the pane (i.e. to connect annotation with a chromatogram). 

To place a line in the pane: 

a) Press the  icon on the menu bar, then move the cursor to the approximate position in the pane and 
click. A line outlined in red will be placed at the indicated position. 

b) Move and/or enlarge the line to the desired size and position in the pane. These activities are done in 
the same manner as when you move or change the size of a window (i.e. to expand the rectangle, you 
can click on a corner and drag it). 

9.3.8 Adding Pages to a Report 

If desired, you can add pages to a report by clicking the  icon. Once pages have been added to a 

report, they can be accessed via the navigation icons . The first icon presents the 
first page in the report, the second icon presents the previous page, the third icon presents the next page 
and the fourth icon presents the last page in the report.  

9.3.9 Font 

The font, font style and size of the alphanumeric characters in the report can be changed by selecting an 
object that contains text (e.g. user annotation [Section 9.3.2] or data [Section 9.3.4]) and selecting Font 
from the menu bar. The Font dialog box (Figure 9-10) will be presented; this is a standard Windows 
dialog box. 

 
Figure 9-10  Font Dialog Box 
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9.3.10  General Information 

The Page dialog box (Figure 9-11) and Display Options dialog box (Figure 9-11) are used to enter a 
variety of general information can be added to the report. The Page dialog box is accessed by right 
clicking in the pane in a region that does not contain an object, and the Display Options dialog box is 
accessed via the Display Options command on the File menu main window. 

 
Figure 9-11:  Page Dialog Box 

 
Figure 9-12:  Display Options Dialog Box  
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9.3.11  Saving and Editing Report Layouts 

A report layout is saved by selecting Save or Save as on the File menu. A dialog box will be presented to 
indicate the file name. Report Layouts have the file suffix rlo (e.g. xxxxx.rlo). 

If desired, you can edit an existing report layout by: 

a) Select Create Report Layout on the File menu of the main Discovery32 window to present the 
Report Layout dialog box. . 

b) Select Open on the File menu of the ReportLayout dialog box and choose the file that you want to 
edit. The file will be loaded and can be edited. 
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Appendix A 

Calibrating the System – Experimental Considerations  
 

A.1 OVERVIEW  

Selection of the standard and the chromatographic separation is based on a broad range of criteria, and a 
wide variety of standards are commonly used. Section A.2 describes the general criteria for standards and 
analytical conditions. It should be recognized that the selection of the appropriate standard and set of 
conditions for a given application is a compromise, some workers like to use an extremely well 
characterized standard (e.g. BSA), while others like to use a standard that is extremely similar to the 
polymer that is being studied.  

For aqueous SEC, 2/mg mL bovine serum albumin (Sigma P-0834) is commonly used. 

For room temperature GPC using THF, polystyrene, Molecular weight 96.4 kD, polydispersity 1.01 is 
used. (TSKstandard Polystyrene, F-10) 

Experimental conditions for SEC calibration with BSA is presented in Section A.4 and experimental 
conditions for GPC calibration with Polystyrene is presented in Section A.4. 

A.2 THE STANDARD 

A good standard for calibrating the system should meet the following criteria: 

• The material should be of known molecular weight and well characterized. 

• The solution should be of known concentration 

• The sample should be monodisperse (Mw/Mn should be between 1.00 and 1.01) 

• The compound should be an isotropic scatterer. The molecular weight should be large enough to 
generate a sufficient light scattering signal and the signals at 15o and 90o should be of the same 
size (for globular proteins, non-isotropic scattering begins as the molecular weight approaches 1 x 
106 daltons. 

• If possible, the standard should be free of aggregations. 

• The dn/dc should be well defined  

• The extinction coefficient of the standard at the monitoring wavelength is required if a UV 
detector is used as the concentration source. 

     A 
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A.3 THE CHROMATOGRAPHY  

• The standard should chromatograph as a single peak 

• Recovery of standard should be 100 % 

• Enough material should be injected to obtain good signals from the light scattering detectors and 
the concentration source detectors. 

• If aggregates are present, they should be well resolved from the monomer.  

• The monomer peak must be well resolved from the terminal peak. 

• The Refractive Index of the Eluent at the temperature of the detector cell must be known when 
the 15 o light scattering detector is used.  

• The Viscosity (in poise) of the eluent at the temperature of the detector cell is required for Rh 
determinations. 

A.4 EXPERIMENTAL CONDITIONS FOR SEC CALIBRATION WITH BSA 

The conditions presented below are typical conditions for the calibration of the system with BSA, and 
were used to generate the figures presented in the manual. These conditions are presented as advisory to 
the user, who should develop and perfect the separation using the instrumentation, column, etc. that is 
available in the facility. It is not unlikely that there may be small differences in the retention time if other 
columns, buffers, etc are employed. 

Standard: BSA (2 mg/mL), Sigma Cat. No P-8034 

Column: YMC-Pack Diol-300 (3000 x 8 mm ID, 5 µm particles), YMC Cat. No. DL30S05-3008WT 

Eluent: Phosphate Buffered Saline (PBS), 120 mM NaCl, 2.7. mM KCl, 10 mM phosphate buffer, 
Sigma Diagnostics #1000-3. 

Flow Rate: 1 mL/min 

Injection Vol: 100 µL 

Order of detection: UV@ 280nm, LS, and RI last 

The outlet from the UV to the inlet of either a Benchtop LS detector or a PDI inside Refractive index 
detector  should be the shortest length of 0.007” ID PEEK tubing or 0.009” ID stainless steel The UV 
channel was assigned to the spare channel; an acquisition rate of 1 Hz (sample interval of 1 sec) was used 
with a collection fraction of 0.1. 

A Precision Detectors low dispersion inline filter was placed before the UV detector, this filter was fitted 
with a 13 mm diameter, 0.2 µm Supor membrane. 
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A.5 EXPERIMENTAL CONDITIONS FOR SEC CALIBRATION WITH POLYSTYRENE 

The conditions presented below are typical conditions for the calibration of the system with polystyrene, 
and were used to generate the figures presented in the manual. These conditions are presented as advisory 
to the user, who should develop and perfect the separation using the instrumentation, column, etc. that is 
available in the facility. It is not unlikely that there may be small differences in the retention time if other 
columns, etc. are employed. 

Standard: polystyrene, Molecular weight 96.4 kD, polydispersity 1.01 is used. (TSKstandard Polystyrene, 
F-10) 

Column: Plgel 5um MIXED-C , 300x7.5 mm  part no 1110-6500 

Eluent: THF 

Flow Rate: 1 mL/min 

     A 



 

A-4  Discovery32 – Appendix A 

 

 

 

 

 

 

 

 

 

 

 

[This page intentionally left blank]



 

Discovery32 - Index  I-1 

INDEX 

A 

Alignment of Peaks 6-15 
Analog Board Setup Dialog Box 3-16 
Analyzing Analytical Data 6-21, 7-19 
Area Calculation (inserting in Report) 9-9 
ASCII File 9-3 
Autocorrelator 8-6 
Autointegration (Discovery32) 5-9 
Autointegration Dialog Box 3-19 

B 

Baseline (establishing a) 6-9, 7-9 
Baseline Type 6-10, 7-10  

Subtraction 5-7, 6-10,7 
Branching 5-25  

C 

Cal Constants 6-13, 6-17,6-19, 7-13 
Calculation Parameters 6-5, 7-5 
Calibration (Chromatography) A-2 
 Experimental Conditions A-2 

Standard A-1 
Calibration File (Location) 2-7 
Calibration LS Channel 7-19 
Calibration Setup Dialog Box 3-14 
Chromatogram Normalizing 6-11 

Smoothing 5-11 
Window 5-6 

Collection Fraction 3-12, 4-2 
Command Types 1-1 
Comm Port Selection 2-7 
Configure System 3-15 
Constants Tab 6-7, 7-7 
Contents of Manual 1-4 
Conventions 1-3 
Correlator Analysis Dialog Box 3-17 
Correlator Information Dialog Box 5-20  
Correlator Configuration Dialog Box 3-17 
Create Layout Report 5-4 

D 

Data Directory 
Precision Acquire32  2-7  

Detectors Menu 3-12 
Detectors Tab 6-6, 7-6 

 
 
Determining Calibration Constants 6-8, 7-8 

RI Constant 6-16 
Diffusion Constant 8-7 
Discovery32 5-1 
Display Detector Data Command 3-10 
Display Options Dialog Box 5-5 
Display Setup Dialog Box 5-20 
Dynamic Light Scattering 8-1 

E 

Elution Tabs 5-18 
End Run Command 3-9 
Establishing a Baseline 6-6 
Export Command 
 Discovery32 5-3 
 PrecisionAcquire32 3-3 
Exporting Data 9-2,  

F 

File Access Region (Discovery32) 5-27 
Fonts (in Report) 9-11  
Form Factor 8-5 

G 

General Information (in reports) 9-12 
GPC 5-21 
 Generating Calibration Curve 5-21 
 Obtaining Data 5-24 

H 

High Angle Light Scattering 8-5 
Hydrodynamic Data 6-21, 7-22 

I 

Information Region (Discovery 32) 5-28 
Inserting Text (in Report) 9-6 
Instrumentation 1-2 
Installation 2-1 
Integration Region 5-8, 6-13, 7-13 
Integration Template 5-8 
Interdetector Volume 6-13 
Introduction 1-1 
Invert IR Chromatogram 5-11 
IR Chromatogram 5-11r 



 

I-2  Discovery32 - Index 

L 

Laser Command 3-22 
Layout Report 5-4 
Light Scattering, Theory 8-1  
Line (in Report) 9-11 
Low Angle Light Scattering 8-5 

M  

Monitor Photon Level Dialog Box 3-21 
Multiple Runs  

Command 3-8 
Dialog Box 3-8 

MW Calc Method 3-14, 4-3 
MW Calc Type Field 3-14 
MW Distribution Plot (inserting in Report 9-6 
MW Distribution Tab 5-17 
MW vs. Elu Tab 5-19 

N 

Normalizing the Chromatogram 6-11, 7-11 
Narrow Standard Information Table 5-22 
Narrow Standard Table Options 5-22  
Natural Polymers 6-1 
Noise 4-1 

O 

Open Command 
 PrecisionAcquire32 3-3 
 Discovery32 6-2, 7-2 
Operate on Chromatogram Tab 5-6 
Overlay Select 5-25 

P 

Pages (in Report) 9-11 
Photon Level 3-20 
Polynomial Setup Dialog Box 5-20  
PrecisionAcquire32  
 File menu 3-2 

Overview  3-1 
Print Setup Dialog Box 5-5 

Printing Data 9-1 

R 

Raw Data Transformation 5-10 
Readback Status Dialog Box 3-18 
References 8-8 
Refractive Index Measurements (use of) 8-5 
Report Layout 5-4, 9-4

 
 
Results Dialog Box 5-14 
 Run Params Tab 5-15  
 Summary Tab 5-14 
Review Menu 3-10 
Rg Distribution Tab 5-16 
Rg. vs. Elution Tab 5-19 
Rh Distribution Tab 5-17 
Rh vs. Elution Tab 5-19 
RI Constant (determining) 6-16, 7-16 
Run Information Dialog Box 3-10 
Run Params Tab (Results Dialog Box) 5-15 
Run Time 4-4 

S 

Sample Information (inserting in Report) 9-7 
Sample Interval 4-2 
Sample Rate 3-16 
Sample Time 4-4 
Saving Report Format 9-13 
Select Active Detectors (PD2000 Compatible 
 Mode) Dialog Box 3-12 
Select Detectors for Display Dialog box 3-12 
Set Baseline 5-7 
Set Integration Region 5-8 
Set Integration Template 5-8 
Setting Parameters (Test Experiment) 2-3 
Set Plot Limits Dialog Box 5-18 
Setup Calculation Dialog Box 5-12 
 Constants Tab 5-14 
 Detectors Tab 5-13 
 Options Tab 5-12 
Setup Menu 3-13 
Setup Overlays Dialog Box 5-26 
Show MW Calculations 3-11 
Single Run Info Command 3-5 
Silent Toggle Command 3-9 
Smoothing 5-11 
Static Light Scattering 8-1, 8-2 
Start Discovery32 Command 
 PrecisionAcquire32 3-10 
Status Bar 

PrecisionAcquire32 3-25 
Stripchart Command 3-21 
Subtract Baseline 5-7 
Summary Tab (Results Dialog Box) 5-14 
Synthetic Polymers 7-1 
System Configuration Dialog Box 3-15 



 

Discovery32 - Index  I-3 

T 

Temperature Sensor Coefficients 3-12 
Test Experiment 2-3 
Text (in Report) 9-6 
Theory 8-1 
Tolerance 3-18, 4-4 
Tool Bar  
 Discover 5-27 
 PrecisionAcquire32 3-23 
Total Area Calculation (in Report 9-9) 

V 

View Chromatogram 6-4, 7-4 
View Menu 
 PrecisionAcquire32 3-4 

W 

Workspace 
PrecisionAcquire32 3-24 

Z 

Zooming 6-11, 7-11 
 



 

I-4  Discovery32 - Index 

 

 

 

 

 

 

 

 

 

 

[This page intentionally left blank] 


